ProVision™

User Manual

By Power Monitors, Inc.
Revised: January 9, 2006
## Contents

**Introducing ProVision™**
- Wizards ................................................................. 1
- Tutorials .................................................................. 2

**Getting Started**
- Opening a Data File .................................................. 3
- Generating a Graph .................................................... 4
- Generating a Report ................................................... 4
- Connecting a Recorder .............................................. 4
- Initializing a Recorder ................................................ 5
- Downloading a Recorder ........................................... 5

**Organizing Information**
- Managing Data .......................................................... 7
- Managing Recorders ................................................... 9
- Using the Explorer .................................................... 10
  - Configuring .......................................................... 10
  - Understanding System Folders ............................... 10
- Using the Shortcut Bar .............................................. 13
  - Configuring .......................................................... 14
  - Working with Groups ............................................. 14
Advanced Features

Working with Graphs ................................................................. 45
  Editing Legends ........................................................................ 45
  Graph Annotations ................................................................. 46
  Selecting Traces ....................................................................... 55
  Creating a Mixed Graph .......................................................... 57
  Changing the Scale Factor ....................................................... 58
  Using the Point Table .............................................................. 59
  Adjusting Traces ...................................................................... 60
  Properties Pane ....................................................................... 61
  Creating Custom Graphs ......................................................... 62
  Creating Custom Graph Templates ......................................... 63

Working with Reports ............................................................... 69
  Exporting Data ....................................................................... 69
  Creating Custom Reports ....................................................... 70
  Using the Custom Report Wizard ............................................. 70
  Changing the Scale Factor ....................................................... 76

Working with Views ................................................................. 77
  Searching for Data ................................................................. 78
  Importing Data Files .............................................................. 78
  Viewing Real-Time Data ......................................................... 79
  Waveform Graph .................................................................. 79
  Meter Display ........................................................................ 80
Customizing the Workspace ................................................................. 82
Archiving Data .................................................................................. 82
Scheduling Events ............................................................................ 82
Types of Records............................................................................. 84
  Interval Records .......................................................................... 84
  Daily Profile Records ............................................................... 87
  Cycle Histogram Records .......................................................... 88
  Minute Histogram Records ....................................................... 90
  Energy Usage Records ............................................................... 91
  Significant Change Records ..................................................... 92
  Event Change Records .............................................................. 94
  Power Outage Records .............................................................. 96
  Flicker Records ........................................................................ 97
  Abnormal Voltage Records ...................................................... 98
  Loose Neutral Records ............................................................. 100
  Waveform Capture Records ..................................................... 102

Additional Resources .................................................................. 105
  Understanding Recorder Records ............................................. 105
  Technical Support ........................................................................ 105

Glossary of Terms ..................................................................... 107

Index .......................................................................................... 109
Introducing ProVision™

ProVision™ is Power Monitors’ next-generation of PQ data analysis software. Sophisticated tools and advanced communications greatly expand the ability to record, manage and analyze power quality data.

The easy-to-use graphical user interface is designed to get both the novice and the advanced user up to speed quickly.

In addition to the comprehensive help guide, numerous wizards provide focused assistance for more complex tasks. Tutorials are also available to visually demonstrate how tasks are accomplished.

Use the following topics to learn more about ProVision™:

- Getting Started gets the user up and running with ProVision™ right away.
- Organizing Information will familiarize the user with ProVision’s powerful data management tools.
- Communications teaches the user about managing PMI recorders.
- Advanced Features tells the user more about the advanced capabilities of ProVision™.
- Additional Resources provides extra information and assistance in using ProVision™.

---

Wizards

Complex tasks are easily accomplished through the use of wizards, which provide step-by-step guidance along the way:

Startup

The startup wizard will walk through some configuration steps before beginning to use ProVision™.
**Custom Graph**

The custom graph wizard will assist in creating graph templates from PQ data.

**Custom Report**

The custom report wizard will assist in creating report templates based on other reports and graphs or data files. Report templates are used to create custom reports.

**Communications Troubleshooting**

The communications troubleshooting wizard will assist with problems communicating with PMI recorders.

**Initialization**

The initialization wizard will walk through the steps needed to initialize a PMI recorder.

---

**Tutorials**

Tutorials are available to demonstrate how to accomplish these tasks:

- **Working with Graphs**
- **Exporting Report Data**
- **Communications**
Getting Started

The basic features of ProVision™ allow the new user to get up and running quickly. To summarize:

Before performing any analysis tasks on power quality data, such as creating a graph or a report, a data file must be opened first. Data files contain power quality data that have been previously recorded by a PMI recorder.

To extract a data file from a PMI recorder, the data from the recorder must be downloaded to the computer.

In addition, all PMI recorders must be initialized before beginning a new recording session.

Opening a Data File

1. To open a data file, click on the File menu, and then click Open.

2. A dialog box appears to browse for data files located anywhere on the system. Select one or more files, and then click Open.

3. Once the file(s) are opened, they are considered active and may be used to generate graphs, reports and perform other operations.

Notes

- Files that may be opened must have one of the following extensions:
  - *.ISF: WinScan data files
  - *.XSF: ProVision™ data files
  - *.EVM: ProVision™ e-mail data files

- A data file that appears in the Explorer may also be opened by double-clicking its icon.

- The current default view determines what will be displayed, e.g. the Header report.
Generating a Graph

1. Open a data file, or activate a data file in the Explorer by clicking its checkbox. (If more than one data file is active, a graph will be generated for each file.)

2. Click on the Graph menu, and then click on one of the available graphs, e.g. Voltage and Current in the RMS Interval submenu.

3. A graph will be created for each active data file.

Note

Custom graphs may be easily created by clicking Custom Graph Wizard in the Tools menu.

Generating a Report

1. Open a data file, or activate a data file in the Explorer by clicking its checkbox. (If more than one data file is active, a report will be generated for each file.)

2. Click on the Report menu, and then click on one of the available reports, e.g. the Header Report.

3. A report will be created for each active data file.

Note

Custom reports may be easily created by using the Custom Report Wizard in the Tools menu.

Connecting a Recorder

1. Connect the recorder to the desired port, if using a wired mode of communications.

   a. If using a wireless mode of communications, such as Bluetooth®, ensure that the wireless hardware is operational and functioning properly. Refer to the hardware manufacturer’s documentation for more information.

2. Click the Recorder menu, and then click Connect. From the list of available connections, click the appropriate connection type.

   a. Additional connections may be added by clicking on Options, and then clicking Recorder Communication Settings.
3. ProVision™ will automatically display information about the connection in the Communication Group pane.

---

**Initializing a Recorder**

1. The recorder must be connected before performing this task.
2. Click the Recorder menu, and then click Initialize.
3. ProVision™ will automatically display information about the initialization process in the Communication Group pane.

---

**Downloading a Recorder**

1. The recorder must be connected before performing this task.
2. Click the Recorder menu, and then click Download Recording.
3. ProVision™ will automatically display information about the download process in the Communication Group pane.
Organizing Information

ProVision™ provides powerful tools for keeping information organized and easily accessible. To access these tools, click on the View menu.

The Explorer pane provides a tree view of all the data files, graphs, reports, views and searches of the system.

The Shortcut Bar pane contains easy access to shortcuts of items that are frequently used.

The Devices pane provides a tree view of all the PMI recorders of the system.

Use the Explorer to manage the data, and use the Devices pane to manage the PMI recorders in the inventory.

Managing Data

An important feature of ProVision™, is its data management capability. Outside programs, such as Windows Explorer, are no longer needed to locate and organize PQ data files. The ProVision™ user interface offers powerful tools to organize existing data files, monitor the arrival of new data files, and much more.

The simplest way now to organize PQ data is by using projects. Projects allow data and workflow to be related in the same way.

For example, if paper records of trouble calls are kept for each customer in separate folders, then creating customer projects in the Explorer would be the best way to manage PQ data.

On the other hand, if paper records of all trouble calls are kept in daily or weekly folders, then creating projects based on time would be a better solution.

Data Files

PQ data files are organized by the projects that are created. A project may be a particular service region, customer, unit of time, or any other convenient grouping of data files.
Projects may contain sub-projects that represent, for example, the ongoing power quality monitoring within a particular region. All projects are located in the Projects system folder inside the Explorer.

For example, based on the figure below, this user has organized his customers into three service region projects: "Region A", "Region B" and "Region C". Each region has a number of customer sub-projects, where Region A has sub-projects "Factory 1", "Factory 2", "Italian Restaurant" and "School 1". Related data files have been placed within these projects accordingly. (The project folders for Regions B & C have been collapsed for clarity.)

Data files may be copied or moved between projects at will. Project folders may be renamed as needed.

**Keeping Things Neat**

If projects or data files become too numerous or cluttered, they may be hidden by right-clicking on the icon and then clicking Hidden. These objects are not removed from the system and may be made visible again by clicking on the View menu, and then clicking Show Hidden Nodes.

Optionally, projects and data files that are no longer in active use, but must be kept around, may be archived. To archive data, right-click on the project or data file icon, and then click Create Archive from the menu.
For items no longer needed, select the icon and press the **Delete** key, or right-click on the icon and then click **Delete** from the popup menu. From the menu bar, click on **Edit** and then click **Delete**. From the toolbar, click the **Delete** button.

**Managing Recorders**

Keeping a handle on PMI recorders is easily accomplished with ProVision™. The **Devices** pane provides the primary location for organizing, scheduling and configuring the recorders.

The **Events** system folder contains all scheduled events for automating recorder tasks, such as downloading data.

The **Recorder Settings** system folder holds all recorder settings that have been preconfigured for future use.

Additional folders may be added to help organize recorders by right-clicking anywhere in the **Devices** pane, and then clicking **Create Folder**.

For example, the figure below shows the **Devices** pane with the two system folders and two additional folders named “Joe’s Recorders” and “Tom’s Recorders”. This ProVision™ user decided to organize his PMI recorder inventory by the technicians that use them.

Recorder icons may be moved to any folder in the **Devices** pane, except system folders, by simply clicking and dragging the icon to the new location.

For items no longer needed, select the icon and press the **Delete** key, or right-click on the icon and then click **Delete** from the popup menu. From the menu bar, click on **Edit** and then click **Delete**. From the toolbar, click the **Delete** button.
Using the Explorer

The Explorer is the main window for organizing system data. It displays all information in a tree view allowing easy access to every part of the system, except PMI recorders, which are managed with the Devices pane.

The Explorer is fully configurable and contains several system folders to assist in managing data.

Configuring

The Explorer is fully configurable for easy viewing.

- To open or close the Explorer, click on the View menu, and then click Explorer. A checkmark appears when the pane is open. The Explorer may also be closed by clicking on the X button in the upper right corner of the pane.

- To toggle the Auto Hide feature, click the pin icon in the upper-right corner of the pane (Explorer must be docked to a side of the application window to use this feature).

- When in Auto Hide mode, Explorer will automatically slide out of sight when the mouse is moved away from the pane. Explorer will slide back into view when the mouse cursor is placed over the Explorer button located on the side of the application window.

- To move the Explorer pane to another location, click, hold and drag the upper bar of the pane. The pane may be docked to another side of the application window, or may remain free floating anywhere on the screen.

- To save space, panes may be grouped together forming a "tabbed pane" arrangement.

- To resize the Explorer, move the mouse cursor over the pane's border. When the cursor changes into a double-headed arrow, click, hold and drag the border to the desired size.

Understanding System Folders

System folders permanently reside in the Explorer and are the major components to the data system of ProVision™. These folders may not be moved, copied, hidden or deleted from the system.

Click on any of the following system folders for more information.
**Recent Downloads**

This folder contains the locations of the computer system that ProVision™ is to monitor for new data files. Each “watcher” icon in the Recent Downloads folder represents a monitored directory on the local computer or network.

To add a new location for ProVision™ to watch, right-click on the Recent Downloads folder icon, and click Add Watcher on the popup menu. A browsing window will appear to find the directory to watch on the computer system.

To remove a watched location from the system, right-click on the watcher icon and then click Delete Watcher on the popup menu.

Watcher icons may be hidden from view by right-clicking on the watcher icon, and then check the Hidden menu item on the popup menu. To view hidden icons, click on the View menu, then check the Show Hidden Nodes menu.

**Graphs and Reports**

This folder contains custom graph templates, custom report templates, and views. When a new template or a view is generated, an icon is created in this folder.

Folders may be created in the Graphs and Reports system folder to help organize the graphs, reports and views that are created.

To create a folder, right-click on the Graphs and Reports icon, or on an existing folder, and then click Create Folder from the popup menu. From the menu bar, click on File and then click Create Folder. From the toolbar, click the Create Folder button.

To remove a folder, graph, report or view, select the item and press the Delete key, or right-click on the icon and then click Delete from the popup menu. From the menu bar, click on Edit and then click Delete. From the toolbar, click the Delete button.

Icons may be hidden in the Graphs and Reports folder by right-clicking on the icon, and then checking the Hidden menu item on the popup menu. To view hidden icons, click on the View menu, then check the Show Hidden Nodes menu.

**Projects**

This folder contains project folders that are used for managing data files. It is structured in a hierarchical, tree-like fashion allowing projects and sub-projects to be created as needed.
At the bottom of the **Projects** folder is a project named "Temporary". This special folder is where data files are placed when they are first opened. These files may then be moved or copied to any other project folder.

To create a folder, right-click on the **Projects** icon, or on an existing folder, and then click **Create Folder** from the popup menu. From the menu bar, click on **File** and then click **Create Folder**. From the toolbar, click the **Create Folder** button.

To remove a folder or a data file, select the item and press the **Delete** key, or right-click on the icon and then click **Delete** from the popup menu. From the menu bar, click on **Edit** and then click **Delete**. From the toolbar, click the **Delete** button.

Icons in the **Projects** folder may be hidden by right-clicking on the icon, and then checking the **Hidden** menu item on the popup menu. To view hidden icons, click on the **View** menu, then check the **Show Hidden Nodes** menu.

---

**Searches**

This folder contains previously saved searches of data files.

Folders may be created in the **Searches** system folder to help organize searches.

To create a folder, right-click on the **Searches** icon, or on an existing folder, and then click **Create Folder** from the popup menu. From the menu bar, click on **File** and then click **New**.

To remove a folder or a search, select the item and press the **Delete** key, or right-click on the icon and then click **Delete** from the popup menu. From the menu bar, click on **Edit** and then click **Delete**. From the toolbar, click the **Delete** button.

Icons in the **Searches** folder may be hidden by right-clicking on the icon, and then checking the **Hidden** menu item on the popup menu. To view hidden icons, click on the **View** menu, then check the **Show Hidden Nodes** menu.

---

**Imported Files**

This folder contains data files that have been imported into the system. Use this folder as a temporary holding place for imported files until they can be moved to an appropriate project folder.

As each import operation is performed, a folder is automatically created in the **Imported Files** system folder that represents a directory on the computer system.
To remove a folder or a data file, select the item and press the **Delete** key, or right-click on the icon and then click **Delete** from the popup menu. From the menu bar, click on **Edit** and then click **Delete**. From the toolbar, click the **Delete** button.

Icons in the **Imported Files** folder may be hidden by right-clicking on the icon, and then checking the **Hidden** menu item on the popup menu. To view hidden icons, click on the **View** menu, then check the **Show Hidden Nodes** menu.

**Deleted**

The **Deleted** bin contains all items that have been previously deleted by the user, but have not yet been permanently removed from the system.

All items in the **Deleted** bin may be restored to their original locations by right-clicking on the item, and then clicking **Restore** from the popup menu.

All items in the **Deleted** bin may be permanently removed by right-clicking on the **Deleted** bin, and then clicking **Empty Deleted Bin**.

To remove and individual item, select the item and press the **Delete** key, or right-click on the icon and then click **Delete** from the popup menu. From the menu bar, click on **Edit** and then click **Delete**. From the toolbar, click the **Delete** button.

Icons in the **Deleted** bin may be hidden by right-clicking on the icon, and then checking the **Hidden** menu item on the popup menu. To view hidden icons, click on the **View** menu, then check the **Show Hidden Nodes** menu.

**Using the Shortcut Bar**

The **Shortcut Bar** is a useful tool for storing frequently used items found in the **Explorer**, such as data files, graphs, reports, views, searches and projects. For example, use the **Shortcut Bar** to quickly launch a commonly used voltage graph from the active data file.
Configuring

The **Shortcut Bar** is fully configurable for easy viewing.

- To open or close the **Shortcut Bar**, click on the **View** menu, and then click **Shortcut Bar**. A checkmark appears when the pane is open. The **Shortcut Bar** may also be closed by clicking on the X button in the upper right corner of the pane.

- To toggle the Auto Hide feature, click the pin icon in the upper-right corner of the pane (the **Shortcut Bar** must be docked to a side of the application window to use this feature).

- When in Auto Hide mode, the **Shortcut Bar** will automatically slide out of sight when the mouse is moved away from the pane. The **Shortcut Bar** will slide back into view when the mouse cursor is placed over the **Shortcut Bar** button located on the side of the application window.

- To move the **Shortcut Bar** pane to another location, click, hold and drag the upper bar of the pane. The pane may be docked to another side of the application window, or may remain free floating anywhere on the screen.

- To save space, panes may be grouped together forming a "tabbed pane" arrangement.

- To resize the **Shortcut Bar**, move the mouse cursor over the pane's border. When the cursor changes into a double-headed arrow, click, hold and drag the border to the desired size.

### Working with Groups

The **Shortcut Bar** can be organized into groups, where a group represents a logical collection of items, such as “Reports”, or “ABC Company Data”. A group has a button with the group’s name, and contains icons of the items added to the group. There’s no limit to the number of groups that can be created, however, groups that are not visible on the screen cannot be accessed.

To create a group, right-click on the **Shortcut Bar**, then select **Add Group** from the popup menu. Type a name to label the group.

To remove a group, click on the group’s button to open it, right-click on the group button and select **Remove Group** from the popup menu. Confirm the removal. The group and all items in it will be removed. (The items will not be removed from the **Explorer**.)
**Working with Items**

Items may be added to a group by simply dragging the item’s icon from the **Explorer** into the group. (The item is not removed from the **Explorer**.)

Items may be added by first selecting the item in the **Explorer**, then right-clicking in the **Shortcut Bar** group and selecting **Add Item** from the popup menu.

Items from the **Recent Downloads**, **Imported Files**, and **Deleted** system folders may not be added.

To remove an item from the group, right-click on the item, and then click **Remove Item** from the popup menu. Confirm the removal. (The item will not be removed from the **Explorer**.)

To resize the icons in a group, right-click anywhere within the group and click **Large Icons** from the popup menu. When checked, the icons in the group will be a larger size.

---

**Using the Devices Pane**

The **Devices** pane is the main window for managing PMI recorders. It displays information in a tree view allowing full access to the recorders. (The Explorer is the tool to use for managing system data.)

---

**Configuring**

The **Devices** pane is fully configurable for easy viewing.

- To open or close the Devices pane, click on the **View** menu, and then click **Devices**. A checkmark appears when the pane is open. The **Devices** pane may also be closed by clicking on the **X** button in the upper right corner of the pane.

- To toggle the Auto Hide feature, click the pin icon in the upper-right corner of the pane (the **Devices** pane must be docked to a side of the application window to use this feature).

- When in Auto Hide mode, the **Devices** pane will automatically slide out of sight when the mouse is moved away from the pane. The **Devices** pane will slide back into view when the mouse cursor is placed over the **Devices** pane button located on the side of the application window.
• To move the **Devices** pane to another location, click, hold and drag the upper bar of the pane. The pane may be docked to another side of the application window, or may remain free floating anywhere on the screen.

• To save space, panes may be grouped together forming a "tabbed pane" arrangement.

• To resize the **Devices** pane, move the mouse cursor over the pane's border. When the cursor changes into a double-headed arrow, click, hold and drag the border to the desired size.

**Understanding the Devices System Folders**

The **Devices** pane contains two system folders, **Events** and **Recorder Settings**, to assist in managing PMI recorders.

These folders cannot be moved or deleted.

**Events**

This folder contains the list of scheduled events that have been created to perform automated tasks, such as performing periodic data downloads from a number of recorders.

There is no limit to the number of scheduled events that can be created.

**Recorder Settings**

Each PMI recorder has settings that determine how and what PQ data to record. These settings can be created on-the-fly and stored for future use in the **Recorder Settings** folder.

There is no limit to the number of sets of customized recorder settings that can be created.

As an example, it may be found that at a particular customer site, a recording interval of 1 second is ideal in addition to some other parameters. This unique recorder setting can be created and stored for the next time the customer site is visited.
Communications

A major part of any PQ data system is the communications between recorders and the computer. ProVision™ makes it easy to connect, configure and download data from PMI recorders.

Modes

Every PMI recorder has at least one way of communicating with the computer.

Refer to the following sections to learn how to use these modes.

Bluetooth®

Bluetooth® is an industry-wide communications protocol that allows wireless connectivity with many of our PMI recorders at a range of up to 30 feet.

(Since Bluetooth® adapters are both built in to PCs and available in the aftermarket, some advice from the company IT or IS department may be required.)

The following information will be helpful when using a recorder via Bluetooth®:

1. Create a new connection by clicking on Options, and then click Recorder Communication Settings. Use the Communication Port Settings window to create a new connection for Bluetooth® communications:
a. Click the **Add** button to create the connection.

b. Type the word “Bluetooth” in the **Name** box. This will be the connection’s name that will eventually be displayed in the **Connection** box.

c. Select “Serial” in the **Communication Type** box.

d. Clear the checkbox to disable **Enable auto detect**.

e. Select the appropriate COM port from the list in the **Serial port** box. Bluetooth® adapters utilize virtual COM ports to transfer data. The COM port the adapter is using must be determined using the adapter’s software, or sometimes by using the Windows Device Manager. (See the adapter manufacturer’s documentation for more details.)

f. Set the baud rate to “57600” in the **Baud rate** box.

g. Click the **Save** button to store the new connection.

2. It is important that any Bluetooth® adapter be set to send and receive on the same COM port. (This is set through the adapter’s configuration menu. See the manufacturer’s documentation for more details.)

3. Sometimes, Bluetooth® adapters require what’s called a “pairing key” to establish a trusted relationship between the computer and a PMI recorder. If prompted for a pairing key, or password, when connecting wirelessly with PMI products, simply enter “pmi”.
4. The Recorder must be powered to communicate or receive information. Apply 120 VAC to the Recorder’s Channel 1 leads. Channel 1 leads are the black boots. If the recorder is still connected to a voltage line it was monitoring, that power will work as well.

5. Once the settings have been selected and the Recorder is powered, connect to the Recorder by clicking on the Recorder menu, and then Connect. From this menu, select the newly-created connection “Bluetooth” from the list.

6. A Bluetooth® “Discovery” operation will occur where the Bluetooth® adapter will look for Bluetooth® devices within range. A window listing these devices will appear and will be similar to this one, depending on the adapter manufacturer:

![Select Device to Connect]

Select the Recorder from the list to establish the connection.

7. To end the Bluetooth connection with the Recorder, click on the Recorder menu and then click Disconnect. Next, disconnect the Recorder’s power supply.

For more information on Bluetooth® technology, visit our Web site at http://www.powermonitors.com/support.html.

**Serial**

Many PMI recorders communicate via RS-232 serial communications.

Use the following information when using a Recorder via Serial port:

1. Attach one end of the serial cable to the serial port on the Recorder. The port is located on the top or side of the unit.

2. Plug the other end of the cable into a serial communications port on the back of the computer.
3. Verify the communications settings by clicking on Options, and then clicking on Recorder Communications Settings. The Communications Port Settings window will appear and may be used to modify the settings of the serial port. A default serial port connection called “RS-232 COM1” may be used or altered as needed.

See the Recorder Communications Settings topic later in this manual for more information on changing communication settings.

4. The Recorder must be powered to communicate or receive information. There are two ways to do this:

   a. Plug one end of the 12-volt power adapter into the mating jack on the DB-9 connector (the end of the serial cable nearest the computer). Plug the other end into an electrical receptacle.

   b. Apply 120 VAC to the Recorder’s Channel 1 leads. Channel 1 leads are the black boots. If the recorder is still connected to a voltage line it was monitoring, that power will work as well.

5. When the serial cable is in place and the Recorder is powered, it is ready to begin communications. Click on the Recorder menu, and then click Connect to choose an appropriate connection. From the list, click on the desired connection, such as the default RS-232 COM1, to connect to the Recorder.

6. To end the serial connection with the Recorder, click on the Recorder menu and then click Disconnect. Next, disconnect the Recorder’s power and unplug the serial cable from both the Recorder and computer.

   **Demo Link**

This special mode is a virtual communications type that is useful for creating test scenarios or for demonstrations.

Utilizing this communications mode a virtual recorder, called a Demo Recorder, may be created. This fully-functional device may be selected for demonstration or testing purposes when no other PMI Recorder is available.

For example, Recorder configuration settings may be changed and tested when all Recorders are in the field.
Types of Recorders

PMI recorders come in several models to accommodate a wide range of PQ data collection needs.

Visit our Web site at www.powermonitors.com or browse the user manuals for more information on PMI recorders.

In addition, ProVision™ offers a virtual recorder called a Demo Recorder. This fully-functional device may be selected for demonstration or testing purposes and utilizes the Demo Link virtual communications mode.

Using a Recorder

ProVision™ provides a sophisticated graphical user interface that expands the usability and management of PMI recorders.

Automating tasks, storing recorder configurations, viewing real-time data, communicating with multiple recorders simultaneously, are all features included with the ProVision™ system.

All PMI recorders function in one of two operational modes: Standby and Ready.

Standby

The Standby mode is used for configuring a PMI recorder in preparation of recording data. The following operations may be performed while in Standby mode:

- Recorder identification
- Recorder initialization
- Data downloading
- Firmware uploading
- Setting date & time
- Retrieving recorder settings

Ready

The Ready mode is used when a PMI recorder is actively collecting PQ data. The following operations may be performed while in Ready mode:
• Recording PQ data

• Displaying real-time PQ data

Note

Normally, it is not necessary to manually change the operational mode of a recorder as ProVision™ automatically changes it.

Adding a Recorder

A PMI recorder can be added to the system manually or it can be detected automatically.

Auto-Detect (default)

Recorders may be automatically detected and temporarily added to the system for the duration they are connected. (If open, the recorders appear in the Devices pane.) Once their presence is no longer detected, they are removed.

This mode is useful for quick communications. To download data for example, simply connect the recorder to the system, click the Recorder menu, and then click Download. No interaction with the Devices pane or any other window is necessary.

Find out how to set the auto-detect mode by going to the Recorder Communications Settings topic.

Manual

Adding recorders manually to the system is useful to perform scheduled events. Once a recorder is manually added, it stays in the system until manually removed.

Use the Devices pane to view all the recorders currently in the system.

1. Click on the Recorder menu, and then click Add.

2. Choose the options that describe the recorder to be added from the Recorders Types window, and then click OK:
3. Complete the **Add Wizard** that appears next:

Here, give the new recorder a name. On subsequent screens, select the communications mode and set communications properties.

4. The new recorder will be added to the **Devices** pane:
Connecting a Recorder

Once a recorder has been added to the system, it must be connected before other operations may be performed.

To connect a recorder, click on the Recorder menu, and then click Connect.

The Communication Group pane will display the progress of the connection:

Disconnecting a Recorder

A connected recorder may be disconnected from the system by clicking on the Recorder menu, and then clicking Disconnect.

The Communication Group pane will display the progress of the disconnection:
Configuring a Recorder

A PMI recorder requires minimal effort to configure for operation.

Use recorder communication settings to add, remove and configure communications ports, such as the COM1 serial port.

Use recorder connection properties to configure an individual recorder.

_recorder Communication Settings_

Every PMI recorder is accessible by a port and has settings that define how the port will be used.

To add, remove or edit existing settings, click on the Options menu, and then click Recorder Communication Settings.

The following window appears displaying a serial port connection, which communicates at a rate of 57,600 baud and is set to automatically detect PMI recorders on the COM1 serial port every 2000 milliseconds (2 seconds).

Every recorder that is added to the system using the “RS-232 COM1” connection shown below will automatically have these properties assigned to it. The properties of a specific recorder, however, may be modified later.
Connection

This box contains the list of connections for the system.

Communication Type

This box displays the list of available communications modes.

Name

Displays the name for this connection type. This name appears in the list of available connections when connecting recorders.

Auto-Detect Settings

Check the Enable Auto-Detect box to use the auto-detect feature. The number displayed in the Interval box is how often the system will check the port for the presence of recorders in milliseconds (ms).

Connection Properties

Each communications mode will have its own unique set of properties.

Add

Use this button to create a new connection. Once created, it will appear in the Connection box.

Remove
Use this button to remove the currently displayed connection. Once removed, the connection will no longer be in the **Connection** box.

**Restore Defaults**

Use this button to reset the default factory settings for the current connection.

**Save**

Use this button to store any changes made to the current connection and close the window.

**Cancel**

Use this button to discard any changes and close the window.

---

**Recorder Connection Properties**

Similar to recorder communication settings, the recorder connection properties only apply to a specific recorder. A recorder that’s been added to the system automatically assumes the connection properties found in the **Recorder Communication Settings** window.

Once the recorder is in the system (accessible in the **Devices** pane), however, its connection properties may be changed as needed.

This is useful if a particular recorder doesn’t respond well with the settings normally used. This may occur, for example, with a PMI recorder that is connected by modem and only operates at a slower baud rate than normal due to line conditions.

To make these changes, click on the **Recorder** menu, and then click **Connection Properties**.

A window similar to the one below will appear. For each type of connection, however, a unique set of properties is displayed.

This window displays the properties of a serial port connection:
Identifying a Recorder

Identification is a quick and simple operation used to find additional information about a connected recorder.

Click on the **Recorder** menu, and then click **Identify**.

The **Communication Group** pane displays the progress of the identification process:

Once completed, click on the **View** button to display additional information about the recorder:
Initializing a Recorder

Initialization is an important operation used to configure a connected PMI recorder prior to recording PQ data. Once a configuration has been completed, save it for future use.

NOTE: Not all selections apply to all recorders. ProVision and the recorders are intelligent devices and will only use the selections that apply to that device being initialized. If a device is connected and a menu selection does not apply to that device, the selections will be “grayed out”.

Click on the Recorder menu, and then click Initialize.

The first screen to appear contains the basic settings used to initialize a recorder:
Record Interval

Select the interval to record or specify the time to record

Number of Channels

Select the numbers to record.

Current Range

Select the current range for the unit.

Circuit Type

Select the type of circuit to monitor. If no selection is made, a wye selection is default.

Interval Graph Overwrite

A check in this box will cause the oldest data to get overwrote once memory is full. Sometimes called FIFO or circular mode.
Report Header

Four lines of option text for a use to put recording notes. Uses can include addresses, meter numbers, etc.

Load

Use this button to retrieve a previously stored configuration from memory.

Restore Default

Use this button to reset a particular setting to its default value. Click on the parameter to be reset before using this button.

Restore All Defaults

Use this button to reset all of the settings to their default values.

Cancel

Use this button to close this window without initializing the recorder.

Advanced

Use this button to access additional recorder settings.

Finish

Use this button to complete the changes.

During the initialization process, ProVision™ sends the configuration settings to the recorder and performs other tasks to initialize the recorder. The Communication Group pane displays the progress of the initialization:
Once completed, the recorder is ready to record data based on the configuration that has been set.

**Advanced Configuration Settings**
Interval Graphs

Check the boxes that you wish to acquire graphs of. If you want harmonics, you can select between phase and magnitude. Be sure to enter in the number of the harmonic you wish to record (up to the 51st)

Harmonic Graphs

Select the number of channels you need to record. If you are doing a three-phase recording you would select 3 or 4 channels (depending if you were recording neutral and ground.)

IEC Flicker (Pst Interval)

For units that are capable of recording IEC Flicker, select Pst Interval.

Voltage Threshold

Enter in the percent of voltage reading that you wish to cause a waveform capture to occur. An example- If your unit is on a 120V service and you set the voltage threshold to be 10%, the unit would require a 12V change in voltage value to occur from one cycle to the next in order for a waveform to be triggered.
**Current Threshold**

Enter in the percent of full scale current that you wish to cause a waveform capture to occur. An example- If your unit is on a 1000A scale and you set the current threshold to be 10%, the unit would require a 100A change in current value to occur from one cycle to the next in order for a waveform to be triggered.

**Period Capture**

A selection here will cause the recorder to capture a waveform at the selected interval.

**Samples/Cycles**

Some recorders allow a lower resolution (number of points) to be captures, thus allowing an increase in the total number of waveforms that can be captured.

**Pre/Post Waveforms**

Enter in the number of cycles you wish to capture before the triggered waveform into the Pre field.

Enter in the number of cycles you wish to capture after the triggered waveform into the Post field.

**Trigger Thresholds**

Select the number of volts (deviation from previous cycle) that would cause a waveform capture to occur.

**Overwrite**

A check in this box will cause the waveforms to overwrite the oldest waveforms once the waveform memory allocation is full.

**Voltage & Current Number of Channels**

Select the number of voltage and current channels to collect waveforms from.

Example- If you select 2 channels, only channels 1 and 2 will collect waveforms. If your unit has 4 channels, channel 3 and 4 will not collect any.
Event Recording Parameters

The “Event Recording Parameters” table contains three columns for each of the four recording channels. “Nominal Voltage” is the voltage against which all events are measured. Factory setting is 120 volts. “Threshold Bands” are the variations in voltage—repeated above and below the nominal—needed to signal a voltage event. Factory setting is 6 volts, meaning that a voltage of less than 114, less than 108, less than 102, etc., or greater than 126, greater than 132, greater than 136, etc., may be considered the start of an event. “Minimum Event Time” is the number of consecutive cycles that must elapse before a new event of the same slope can be triggered. Factory setting is 10 cycles.

Enter any changes in the appropriate boxes. The Recorder will record events that meet or exceed your settings. Once the data have been collected and downloaded, you can prepare an Event Change Table.

Loose Neutral Parameters

Trigger Duration= number of seconds that the condition has to be present for it to be considered a loose neutral.

Range= Number of volts above or below nominal voltage that the condition would need to be reached to be considered a loose neutral. (i.e.- nominal =120VAC and a range of 12 vac, either L1 or L2 would need to be outside of the 108 to 132 vac range to meet the condition)
Difference= The number of volts that the between channel 1 and channel 2 need to be in order for the condition to be considered a loose neutral. (i.e.- L1 would need to be 136 or 104 vac if L2 was 120vac to meet the condition of a loose neutral)

![Edit Settings]

Flicker Parameters

The “Flicker Parameters” table contains three columns. For each time span in the first column (“Period”), you may set the percentage of variation (“Tolerance”) and the minimum number of cycles (“Limit”). A flicker event occurs when the voltage varies from the nominal by more than the tolerance for more cycles than the limit within the given period. For example, using the factory settings for a 10-second period, a flicker event would be recorded when five or more variations of more than 1 percent occur within 10 seconds.

Enter changes in the appropriate boxes.

The Recorder will record events that meet or exceed your settings. Once the data have been collected and downloaded, you can prepare a Flicker Report.

Note- These settings are for the IEEE Standard 141 report. Settings for IEC Flicker are in advanced settings 1/6 and 2/6.
Abnormal Voltage

This window displays a chart of low and high abnormal voltage ranges. There are four pages of charts—one for each recording channel in use. To switch from channel to channel, click on the numbered tab at the top of the charts.

For each channel/page, there are two charts: “Standard Settings” and “Custom Settings.” The standard chart lists five nominal voltages (120, 208, 240, 277, and 480). To the left of the nominal voltages are columns marked “low range” and “high range.” These numbers determine the values in the five columns to the right of the nominals. For example, for the nominal 120, the default low-range setting is 6 and the default high-range setting is 12. In this case, a low-range abnormal voltage event will be recorded if the voltage is below 114 or above 126. (That is, 120 volts plus or minus 6, the low-range setting.) A high-range abnormal voltage event will be recorded if the voltage drops below 108 or peaks above 132. (Again, 120 volts plus or minus 12, the high-range setting.)

The custom scale works much the same way, except you are permitted to change the two nominal voltages.

If you want the Recorder to use only the settings in the standard chart, check “Standard” at the bottom of the page. If you want the Recorder to use only the settings in the custom chart, check “Custom.” If you want the Recorder to use both charts, check both boxes.

The Recorder will record the date and time of voltages which lie outside the ranges you have defined. Once the data have been retrieved, you can prepare an Abnormal Voltage Report.
**Channel Names**

Enter in any tag names for channels.

**Disable Keypad**

A check in this box will disable the unit keypad.

**Display High Resolution**

A check in this box will provide a display with an extra significant digit.

**Modem Settings**

This is the number of rings the Recorder will wait before answering a call. If a Recorder is located in a substation with a phone line also used for voice communications, you may want to set the ring count higher. That would allow a person the chance to answer the phone before the Recorder modem picks up. Factory setting is 3 rings.

**LED Indicator**

This setting has no effect on the Recorder.
Interval Graph Memory Usage

Interval data refers to data recorded for each interval in the recording period. For example, if the recording interval is 1 second and the recording period is 1 hour, the Recorder will save average, maximum and minimum measurements for 3,600 intervals. (See Recording Interval in this section.) Most of the Recorder’s interval memory is reserved for this stripchart data. The percentage in this field equals the Interval Recording Overwrite is enabled) or turning off (when Interval Recording Overwrite is not enabled). Factory setting is 100 percent.

Rotary Switch Overwrite

If checked, this feature prevents a user from changing Recorder settings manually from the faceplate keypad, or rotary switches on the IV Recorders. Factory setting is not checked (not enabled). For more information see the Recorder Manual.

Significant Change Threshold

This setting determines the change in voltage needed before the Recorder records a significant change. Factory setting is 3 volts. The permitted range is 1-8 volts.

Downloading a Recorder

After a PMI recorder has collected PQ data, it is necessary to download the data to the computer for further analysis. (The recorder must be connected before downloading can occur.)

Click on the Recorder menu, and then click Download Recording.

During the downloading process, the Communication Group pane displays the progress of the operation:
Once the download is complete, enter a name for the new data file, which is then placed in the Recent Downloads folder. Click the View button to open the file to perform data analysis, such as generating graphs and reports.

Retrieving a Setup

The settings of a recorder, those that were sent to it during initialization, may be retrieved at any time. (The recorder must be connected before the settings can be retrieved.)

Click on the Recorder menu, and then click Retrieve Settings.

During the retrieval of the settings, the Communication Group pane displays the progress of the operation:

Once completed, click on the Export button to save the settings for future use, or click on the Open button to view the settings:
Use this screen to modify the settings of the recorder, and then click **Finish** to initialize the recorder with the changes.

**Setting the Date and Time**

To set the data and time of a PMI recorder, click on the **Recorder** menu and then click **Date and Time**.

The current date and time of the recorder is retrieved and displayed in the following screen:

**Editing Box**

Use the editing box to manually change the date and time. Be sure to use a 24-hour time format, e.g. “4:57 PM” is “16:57” in 24-hour format.

Use the drop-down arrow to choose a date from the calendar.

**Now**
Use this button to overwrite the contents of the editing box with the current date and time.

**Use PC Time**

Check this box to send the date and time of the computer to the recorder instead of the time shown in the editing box.

**OK**

Click this button to send the date and time to the recorder.

**Cancel**

Click this button to close this screen without sending the date and time to the recorder.

During the setting of the date and time, the **Communication Group** pane displays the progress of the operation:

![Setting date/time](image)

**Uploading Firmware**

Periodically, the firmware of a PMI recorder needs to be updated. This is easily accomplished once the recorder is connected to the system.

Click on the **Recorder** menu, and then click **Upload Firmware**. (If this menu is not visible, click on the **Options** menu and then check the **Show Advanced Operations** menu.)

ProVision™ automatically locates the appropriate firmware file for the recorder, and if a newer version of firmware is found, a prompt will appear to verify that it is the one to use:
Click Yes to continue the operation, or click No to stop it.

During the uploading of the firmware file, the Communication Group pane displays the progress of the operation:

Click the Abort button to cancel the operation.

Recording Data

A PMI recorder is ready to record PQ data when it is disconnected from the computer. The communications cable may be physically removed from the recorder to also disconnect the device.

After disconnection, the recorder will perform a countdown from one to two minutes, depending on the recorder model, and then it will begin recording when voltage is detected on the voltage inputs. (See the recorder owner’s manual for more information.)
Advanced Features

ProVision™ contains many advanced features for users who want to get the most out of their power quality data.

Working with Graphs

Graphs provide a visual look at the power quality data that’s been recorded. ProVision’s many powerful features will enhance the analysis of the data and improve the presentation of graphs.

Editing Legends

The legend of a graph shows the colors of the traces and their meaning. For example, the legend below shows three graphic elements for three of the traces. “Min V”, “Ave V” and “Max V” describe the meaning of each trace, and dark green, green and red are the colors of their respective traces in the graph.

Using the Legend Editor, each legend element can be changed as required. In addition, new elements may be added or existing elements may be removed from the legend.

Using the Legend Editor

To launch the Legend Editor, click on the Tools menu, and then click Legend Editor.
The Legend Editor has three sections: **Legend**, **Standard** and **Advanced**.

**Legend**

Use this section to add or remove legend elements by using the + and – buttons, respectively. Each item in the list represents a legend element that will appear on the graph.

Select a legend element from the list to change its properties found in the next two sections.

**Standard**

Use this section to edit the text and color of the currently highlighted legend element.

**Advanced**

Use this section to alter the data represented by the currently highlighted legend element.

Optionally, hide the legends by checking the **Hide legends** checkbox.

Click the **Close** button when done making changes.

**Graph Annotations**

Analysis of graph data is greatly enhanced when adding comments and other markings to draw attention to points of interest. To do this, ProVision™ provides a number of graph annotation tools.
In addition to being able to annotate graphs, graphs with event changes or waveform capture events have clickable link annotations. These special annotations allow access to the captured data of the event by clicking on the annotation.

**Using Link Annotations**

Link annotations are automatically created in voltage and current interval graphs when there are event changes or waveform capture events present in the data.

Each annotation is located on the graph at the point in time when the event change or waveform capture event occurred.

**Event Change Link Annotation**

The annotation symbol for event changes is a gray circle. When clicking on the circle, an Event Change Table Report is created for the event change.

To launch the report, move the mouse over the circle. When the cursor changes into a hand-shaped icon, click on the circle.

**Waveform Capture Link Annotation**

The annotation symbol for waveform capture events is a vertical gray line. When clicking on the line, a graph with the waveform capture is created.

To launch the graph, move the mouse over the line. When the cursor changes into a hand-shaped icon, click on the line.
Annotating Graphs

Graphs may be annotated by the user to provide helpful information about the data and to highlight areas of interest.

There are eight annotation tools available on the Graph Annotation toolbar:

- **Pointer for Annotation**: Use this tool for selecting or moving a graph annotation already placed on the graph. When using this tool, the cursor changes into a hand-shaped icon indicating that the mouse is pointing at a graph annotation or a link annotation.

- **Text Annotation**: Use this tool to add textual information anywhere on the graph. Click on the Text Annotation button, and then click on the graph at the desired location. The words “Text annotation” appear on the graph and may be edited in the Properties pane along with other properties.

After the annotation has been added, the cursor changes into the Pointer for Annotation tool to allow the selection and movement of text.

To remove the annotation, move the mouse over it and right-click, then click Remove Annotation Element from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)
The following appearance and layout properties of the text annotation may be changed in the **Properties** pane:

**Color** – the color of the text

**Horizontal Text Alignment** – how the text is horizontally aligned in relation to the insertion point, i.e. the text will be to the left, the right or be centered on the point where clicked on the graph.

**Text** – the text of the annotation.

**Text Mode** – the direction of the text, either “horizontal” or “vertical”.

**Vertical Text Alignment** – how the text is vertically centered in relation to the insertion point, i.e. the text will be at the top, the bottom or be centered on the point where clicked on the graph.

**Bound to Axis** – the Y-axis (see the *Y* property, below) to which the annotation is attached, either “left” or “right”.

**Plot** – the plot in which the annotation is located. Plots are numbered from top to bottom, starting with “1”.

**X** – the X-coordinate of the annotation’s insertion point. The number represents the horizontal location in relation to the bottom axis’ unit of measurement, such as “seconds”.

**Y** – the Y-coordinate of the annotation’s insertion point. The number represents the vertical location in relation to the left or right axis’ (see the **Bound to Axis** property, above) unit of measurement, such as “volts”.

**Horizontal Line Annotation**

Use this tool to draw a horizontal line across the graph.

Click on the **Horizontal Line Annotation** button, and then click on the graph at the desired location. After the annotation has been added, the cursor changes into the **Pointer for Annotation** tool allowing the selection and movement of the line.

Properties for this annotation may be viewed and edited in the **Properties** pane.

To remove the annotation, move the mouse over it and right-click, then click **Remove Annotation Element** from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)
The following appearance and layout properties of the horizontal line annotation may be changed in the **Properties** pane:

**Color** – the color of the line.

**Line Type** – the appearance of the line, which essentially means the thickness and style, such as a “ThinSolid” line.

**Text** – the text associated with the line.

**Text Placement** – the location of the text, if any, in relation to the plot, e.g. “CenterInside” places the text inside the plot and centered between the left and right sides.

**Bound to Axis** – the Y-axis (see the Y property, below) to which the annotation is attached, either “left” or “right”.

**Plot** – the plot in which the annotation is located. Plots are numbered from top to bottom, starting with “1”.

**Y** - the Y-coordinate of the annotation’s insertion point. The number represents the vertical location in relation to the left or right axis’ (see the **Bound to Axis** property, above) unit of measurement, such as “volts”.

---

**Vertical Line Annotation**

Use this tool to draw a vertical line across the graph. This is the only annotation that can be created that will span across more than one plot of a graph.

Click on the **Vertical Line Annotation** button, and then click on the graph at the desired location. After the annotation has been added, the cursor changes into the **Pointer for Annotation** tool allowing the selection and movement of the line.

Properties for this annotation may be viewed and edited in the **Properties** pane.

To remove the annotation, move the mouse over it and right-click, then click **Remove Annotation Element** from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)

---

**Properties**

The following appearance and layout properties of the vertical line annotation may be changed in the **Properties** pane:

**Color** – the color of the line.
**Line Type** – the appearance of the line, which essentially means the thickness and style, such as a “ThinSolid” line.

**Text** – the text associated with the line.

**Text Placement** – the location of the text, if any, in relation to the plot, e.g. “CenterInside” places the text inside the plot and centered between the top and bottom sides.

**X** - the X-coordinate of the annotation’s insertion point. The number represents the horizontal location in relation to the bottom axis’ unit of measurement, such as “seconds”.

---

**Arrow Annotation**

Use this tool to add one of eight directional arrows to the graph.

Click on the **Arrow Annotation** button, and then click on the graph at the desired location. To change the arrow type from the toolbar, click on the dropdown arrow next to the **Arrow Annotation** button and select the desired arrow from the list.

Properties, such as **Arrow Type**, may be viewed and edited in the **Properties** pane.

After the annotation has been added, the cursor changes into the **Pointer for Annotation** tool allowing the selection and movement of the arrow.

To remove the annotation, move the mouse over it and right-click, then click **Remove Annotation Element** from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)

---

**Properties**

The following appearance and layout properties of the arrow annotation may be changed in the **Properties** pane:

**Arrow Type** – the direction of the arrow, e.g. the “NorthEast” arrow type points in the upper-right direction.

**Color** – the color of the arrow.

**Horizontal Text Alignment** – how the text, if any, is horizontally aligned in relation to the insertion point, i.e. the text will be to the left, the right or be centered on the point where clicked on the graph.

**Text** – the text associated with the arrow.

**Text Mode** – the direction of the text, either “horizontal” or “vertical”.
**Vertical Text Alignment** – how the text, if any, is vertically centered in relation to the insertion point, i.e. the text will be at the top, the bottom or be centered on the point where clicked on the graph.

**Bound to Axis** – the Y-axis (see the Y property, below) to which the annotation is attached, either “left” or “right”.

**Plot** – the plot in which the annotation is located. Plots are numbered from top to bottom, starting with “1”.

**X** – the X-coordinate of the annotation’s insertion point. The number represents the horizontal location in relation to the bottom axis’ unit of measurement, such as “seconds”.

**Y** – the Y-coordinate of the annotation’s insertion point. The number represents the vertical location in relation to the left or right axis’ (see the **Bound to Axis** property, above) unit of measurement, such as “volts”.

**Line Annotation**

Use this tool to draw a line in any direction desired. The line, however, can only be drawn inside of one plot as determined by the **Plot** property, below. (Other properties may be viewed in the **Properties** pane, also.)

Click on the **Line Annotation** button, and then click on the graph at the desired location to begin the line. Next, move the cursor, and then click on a location to end the line.

To move the line, click and drag the endpoints of the line to their new locations. Move the cursor over an endpoint until the cursor changes into a hand-shaped icon and then click and drag the endpoint.

After the annotation has been added, the cursor changes into the **Pointer for Annotation** tool allowing the selection and movement of the line.

To remove the annotation, move the mouse over it and right-click, then click **Remove Annotation Element** from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)

**Properties**

The following appearance and layout properties of the line annotation may be changed in the **Properties** pane:

**Color** – the color of the line.
**Horizontal Text Alignment** – how the text, if any, is horizontally aligned in relation to the insertion point, i.e. the text will be to the left, the right or be centered on the point where clicked on the graph.

**Text** – the text associated with the line.

**Text Mode** – the direction of the text, either “horizontal” or “vertical”.

**Vertical Text Alignment** – how the text, if any, is vertically centered in relation to the insertion point, i.e. the text will be at the top, the bottom or be centered on the point where clicked on the graph.

**Bound to Axis** – the Y-axis (see the Y property, below) to which the annotation is attached, either “left” or “right”.

**Plot** – the plot in which the annotation is located. Plots are numbered from top to bottom, starting with “1”.

**X** – the X-coordinate of the line’s starting point. The number represents the horizontal location in relation to the bottom axis’ unit of measurement, such as “seconds”.

**X2** – the X-coordinate of the line’s end point. The number represents the horizontal location in relation to the bottom axis’ unit of measurement, such as “seconds”.

**Y** – the Y-coordinate of the line’s starting point. The number represents the vertical location in relation to the left or right axis’ (see the Bound to Axis property, above) unit of measurement, such as “volts”.

**Y2** – the Y-coordinate of the line’s end point. The number represents the vertical location in relation to the left or right axis’ (see the Bound to Axis property, above) unit of measurement, such as “volts”.

**Pointer Annotation**

Use this tool to quickly draw a line with text at one end. This annotation is a combination of the **Text Annotation** and **Line Annotation** tools.

Click on the **Pointer Annotation** button, and then click on the graph at the desired location to begin the line. Next, move the cursor, and then click on the location to end the line. The word “Pointer” appears on the graph and may be edited in the **Properties** pane along with other properties.

To move the line, separately click and drag the endpoint of the line (furthest away from the text) and the text itself. Move the cursor over the endpoint until the cursor changes into a hand-
shaped icon and then click and drag the endpoint. Likewise, move the cursor over the text until the cursor changes into a hand-shaped icon and then click and drag the text.

After the annotation has been added, the cursor changes into the **Pointer for Annotation** tool allowing the selection and movement of the line and text.

To remove the annotation, move the mouse over it and right-click, then click **Remove Annotation Element** from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)

**Properties**

The following appearance and layout properties of the pointer annotation may be changed in the **Properties** pane:

**Color** – the color of the line and text.

**Text** – the text of the pointer.

**Bound to Axis** – the Y-axis (see the **Y** property, below) to which the annotation is attached, either “left” or “right”.

**Plot** – the plot in which the annotation is located. Plots are numbered from top to bottom, starting with “1”.

**Text X** – the X-coordinate of the text’s insertion point. The number represents the horizontal location in relation to the bottom axis’ unit of measurement, such as “seconds”.

**X** – the X-coordinate of the line’s endpoint. The number represents the horizontal location in relation to the bottom axis’ unit of measurement, such as “seconds”.

**Text Y** – the Y-coordinate of the text’s insertion point. The number represents the vertical location in relation to the left or right axis’ (see the **Bound to Axis** property, above) unit of measurement, such as “volts”.

**Y** – the Y-coordinate of the line’s endpoint. The number represents the vertical location in relation to the left or right axis’ (see the **Bound to Axis** property, above) unit of measurement, such as “volts”.

**X-Axis Annotation**

Use this annotation to quickly mark a position on the X-axis.
Click on the **X-Axis Annotation** button, and then click on the graph at the desired location. The X-axis itself doesn’t have to be clicked; the annotation will automatically anchor itself at the X coordinate of the cursor when the mouse is clicked.

The words “Axis Annotation” appear on the graph and may be edited in the **Properties** pane along with other properties.

After the annotation has been added, the cursor changes into the **Pointer for Annotation** tool allowing the selection and movement of the annotation.

To remove the annotation, move the mouse over it and right-click, then click **Remove Annotation Element** from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)

### Properties

The following appearance and layout properties of the X-axis annotation may be changed in the **Properties** pane:

- **Color** – the color of the text.
- **Text** – the text of the annotation.
- **X** – the X-coordinate of the annotation’s anchor point. The number represents the horizontal location in relation to the bottom axis’ unit of measurement, such as “seconds”.

### Selecting Traces

Plots of a graph may contain many traces of data points. Sometimes, however, the interesting data is hard to see because too much information is in the graph. Therefore, removing the unneeded traces is a good way to emphasize the important data.

To select specific traces of a graph, click on **Tools**, and then click on **Select Traces** to bring up the editing window:
The Select Traces window has two sections: **Trace** and **Select By**.

**Trace**

This section lists all available traces for the graph and what information they represent.

Highlight each trace in the list to be kept in the graph by clicking anywhere in the trace’s row. Hold the **Shift** key down to select a group of traces at the same time by clicking on the first and last trace in the group. Hold the **Ctrl** key down to select multiple traces one at a time.

As each trace is highlighted, the grid on the right is updated accordingly.

**Select By**

This section uses a grid for selecting traces by channel or by type (minimum, average and maximum).
Use the buttons at the right of the grid to select traces for an entire channel. Use the buttons on the bottom of the grid to select traces of a particular type. Use the **Select All** and **Unselect All** buttons to quickly select or unselect all traces of the graph.

As traces are selected, checkmarks are placed in the appropriate boxes of the grid. In addition, the list of traces on the left is updated accordingly.

Click **OK** to keep the changes, or click **Cancel** to ignore them.

### Creating a Mixed Graph

It is sometimes useful to see data from different sources in one combined graph. The combined graph is called “mixed” since it merges data from more than one source.

Sources can be traces of data from a single data file, or they can be from multiple data files. There must be graphs on the screen to use this feature. If not, generate one or more graphs to create data sources.

To begin creating a mixed graph, click on the **Tools** menu, and then click **New Mixed Graph** to launch the mixed graph window.

Use this window to drag traces, or entire plots from the source data files on the right to the left side of the window. The available data sources are listed in the **Available Graphs** box in the upper right corner.
Changing the Scale Factor

Changing the scale factor of the data is easily accomplished. Click on the Tools menu, and then click Scale Factor to open the Edit File Parameters window.

Use this window to adjust the scale factor for each channel’s voltage and current data for the currently selected data file on the left. If there is more than one active data file, select the data file for which the scale factor is to be changed.

Any changes made to the scale factor are immediately applied to all the reports and graphs for the data file.
Using the Point Table

The point table is a handy reference to view the exact values of a graph at any given point.

To turn the point table on or off, right-click on the graph and then select **Toggle Point Table** from the popup menu. Alternatively, use the **Alt+T** shortcut key combination if the graph is currently selected.
The point table appears to the right of the graph and lists all values of every trace at the current time. The current time is indicated by a black vertical reference line.

To change the time, move the mouse over a trace of data points. When the cursor changes into a hand-shaped icon, click the trace to move the reference line.

### Adjusting Traces

Comparing aberrations of data in a graph is easily accomplished by selectively moving traces on the graph.

To move a trace(s), unlock it first by clicking on the **Tools** menu, and then click **Unlock X Axis**. Choose the trace(s) to move from the list in the **Trace Selector** window.

All unlocked traces will appear in the graph as thick lines and can be moved by dragging them left or right. After moving the trace(s), click the **Unlock X Axis** menu or toolbar button to lock the traces in place.
In the example above, the minimum voltage trace for channel 2 was moved to the left to align a low voltage dip with another low voltage condition at an earlier point in time. Notice that the units of measurement along the X-axis are no longer in the original time scale, but are now shown as a relative time scale.

Properties Pane

All graphs and graph annotations have properties, e.g. the title of the graph, that can be changed as needed. To make these changes easy, the Properties pane displays all available properties in a simple, editable grid:
Creating Custom Graphs

When a new graph is to be generated from a custom graph template, activate one or more data files and double-click the desired graph template icon in the Graphs and Reports folder.

When prompted by the Open Template Graph window, choose a data file for each index as required:

NOTE

If there is more than one Index, then the graph template was created from more than one graph. Mixed graphs can be used to generate these kinds of graph templates.
Creating Custom Graph Templates

Custom graph templates are easily created from existing graphs, or by using the custom graph wizard.

**Saving a Graph as a Template**

Any graph on the screen can be saved as a custom graph template by clicking the **Save Graph as Template** icon in the **File** menu.

When prompted, give the graph template a name that will be displayed in **Explorer**. The template will be saved in the **Graphs and Reports** folder with a graph template icon.

**Using the Custom Graph Wizard**

The custom graph wizard helps to easily create graph templates that may be used repeatedly to generate custom graphs.

From the **Tools** menu, or by right-clicking on the **Graphs and Reports** folder in **Explorer**, click on **Custom Graph Wizard** to begin.

Use the following steps to complete the wizard.

**Add Plots to Graph**

Each graph will contain one or more plots on which to display graphical data. Each plot, for example, may represent data from each channel of the recording.

There may have up to 6 plots of data on a custom graph. Add or remove plots as needed using the buttons above.

A preview of the custom graph is on the right and is updated changes are made. The red, vertical bar shows which plot is currently highlighted.

Click the **Next** button to continue customizing the graph, or click **Finish** to complete the changes. Click **Cancel** to end the wizard.
Add Axes to Plots

Every plot should have at least one vertical, or y-axis, to describe the type of data being displayed. Usually, this axis is on the left, however, it can be shown on an axis on the right side of the graph or even show axes on both sides of the plot to display two types of data.

For each plot in the graph, decide if there is to be an axis on one or both sides. Then, for each axis, give it a name in the Label field and choose what kind of data is being displayed, e.g. voltage, current, power, etc., from the list of available quantities in the Quantity field.

As the graph is customized, the changes will update the graph preview screen to the right. The red, vertical bar shows which plot is being modified.

Click the Back button to return to the previous screen. Click the Next button to continue customizing the graph, or click Finish to complete the changes. Click Cancel to end the wizard.
Adding Traces to Axes

Every axis added to the graph will have one or more traces, or lines, of data points associated with it. Traces of similar data, such as the maximum data points for all four channels, may be displayed on one axis.

For each plot of the graph, choose which data channels and data point types (minimum, average and maximum) will be displayed for the left and right axes, as applicable. Use the square buttons to quickly select or deselect a row of data point types or a column of data channels.

As traces are added or removed, the graph preview on the right is updated accordingly. The red, vertical bar shows which plot is being modified.

Click the Back button return to the previous screen. Click the Next button to continue customizing the graph, or click Finish to complete the changes. Click Cancel to end the wizard.
Trace Properties

Individual traces of data points have customizable properties. The color or the style of each line can be changed to make certain data stand out more than others.

Look at the traces for each plot of the graph and change the line color or line style of the traces as needed.

As the color or style of a line is altered, the graph preview on the right will update to show the changes. The red, vertical bar shows which plot is being modified.

Click the Back button return to the previous screen. Click the Next button to continue customizing the graph, or click Finish to complete the changes. Click Cancel to end the wizard.
Add Legends

Legends describe what particular trace color represents, e.g. a red trace may be the maximum voltage for all channels.

Use the list on the left to change the color and text of each legend. Legends may be added or removed, and their properties may be changed, too.

As changes are made to the legends, the graph preview on the right will be updated accordingly.

Click the Back button to return to the previous screen. Click the Next button to continue customizing the graph, or click Finish to complete the changes. Click Cancel to end the wizard.
Graph Title

Give the graph a title which will be displayed at the top. Since the customized graph will be saved as a template for future use, it’s necessary to give the template a name, too.

Enter a title to be displayed at the top of the graph. Any changes made to the graph title will be shown in the graph preview on the right.

Also, type a name for the template that will appear in the Graphs and Reports folder.

Click the Back button return to the previous screen. Click the Next button to continue customizing the graph, or click Finish to complete the changes. Click Cancel to end the wizard.
Wizard Finished

Congratulations! A custom graph template has been successfully created.

To locate this template, go to the **Graphs and Reports** folder in **Explorer**. Double-click on the template icon to create a custom graph based on the data from one of the currently checked data files.

**NOTE**

Not all files will contain the data requested by the graph template.

Click on the **Finish** button to end the wizard.

**Working with Reports**

Reports provide a tabular presentation of data from a PQ data file.

**Exporting Data**

It can be useful to present a report in other applications, such as Microsoft Word or Excel.
In addition, rich-text format (RTF), hypertext markup language (HTML) and comma-separated values (CSV) are also available for export.

To export a report into one of these formats, simply right-click on the report and choose the format from the popup menu. A new window will appear for the appropriate application with the report data. (Applications like Word and Excel are assumed to be installed on the computer.)

**Creating Custom Reports**

There are two ways to create a custom report:

- **From the Graphs and Reports folder in the Explorer:**
  
  Double-click the desired report template icon to create a new report from the data in the file. (A data file must active first.) If more than one data file is active, a report will be generated, and may be saved, for each file.

  The report will be created as an RTF document in the default RTF document viewer, usually WordPad unless Microsoft Word or other application is installed.

- **From a data file:**

  Double-click the report template icon located under the data file in the Explorer, as shown below:

  ![Custom Report Icon](image)

  The report may be saved and will be created as an RTF document in the default RTF document viewer, usually WordPad unless Microsoft Word or other application is installed.

**Using the Custom Report Wizard**

The custom report wizard easily creates report templates that may be used repeatedly to generate custom reports as RTF documents.

From the Tools menu, or by right-clicking on the Graphs and Reports folder in Explorer, click on Custom Report Wizard to begin.

Use the following steps to complete the wizard.
Choose What to Create

Select an option to generate a custom report template, or to generate a custom report from a specific data file.

Choose one of the two options at the top of the window. If creating a custom report from a data file, select one of the data files from the list.

Click the Next button to continue the wizard. Click the Cancel button to end the wizard.

Build the Report

Build the custom report by adding graphs, reports and custom graphs as needed. Every graph, report and custom graph in the system can be found by browsing the list of Available Items.
If a graph can’t be found to complete the report, create a custom graph without leaving this wizard by clicking the **Launch Graph Wizard** button.

From the list of **Available Items** on the left, highlight the elements desired and click the > button to add the item. Use the Ctrl and Shift keys to highlight multiple items in the list at the same time.

Click the >> button to add all the available items.

Use the < button to remove selected items from the report, or use the << button to remove all the selected items.

The order in which selected items appear on the right is the same order that they will appear in the custom report. Use the Up and Down buttons to change the order of the selected items.

**NOTE**

Among the available items, the following report elements are useful for enhancing custom reports:

- Introduction
- Customer Information
- Company Information
- Header Report

Each of these elements may be customized for the custom report later in the wizard.
Click the **Back** button to return to the previous screen. Click the **Next** button to continue the wizard, or click the **Finish** button to complete the changes. Click **Cancel** to end the wizard.

*Modify Parameters and Settings*

If applicable, the data parameters and other settings can be changed to customize the report to fit specific needs. For example, if a data file, on which the report is based, contains a lot of data points, it may make sense to only show a small portion of the recording where the data of interest is located.
Click the Back button to return to the previous screen. Click the Next button to continue the wizard, or click the Finish button to complete the changes. Click Cancel to end the wizard.

**Modify Report Elements**

Each report element that’s chosen to be a part of the custom report appears on the left in the list of Selected Items.

For each item in the list that has editable parameters, click on a button to make changes. For example, to modify the text that appears in the introduction of the report, highlight the Introduction item on the left, and click the Header Text in the Parameters section on the right.

Some parameters will not be modifiable for an item and will be disabled.

Restore the default settings of a report element by clicking the Set to Defaults button.
Click the **Back** button to return to the previous screen. Click the **Next** button to continue the wizard, or click the **Finish** button to complete the changes. Click **Cancel** to end the wizard.

**Name the Custom Report**

Enter a name for the custom report. This is the name that will appear in the **Explorer**.

If the report is based on a data file:

- Check the **Generate Report** box to have the wizard launch the report as a RTF document in the default RTF document viewer, usually WordPad unless Microsoft Word or other application is installed.
  - The option will be given to save the custom report as an RTF file to the computer system.
Click the Back button to return to the previous screen, or click the Finish button to complete the changes. Click Cancel to end the wizard.

**Changing the Scale Factor**

Changing the scale factor of the data is easily accomplished. Click on the Tools menu, and then click Scale Factor to open the Edit File Parameters window.

Use this window to adjust the scale factor for each channel’s voltage and current data for the currently selected data file on the left. If there is more than one active data file, select the data file for which the scale factor is to be changed.

Any changes made to the scale factor are immediately applied to all the reports and graphs for the data file.
Working with Views

A view is a template that will create any combination of graphs or reports from an active data file and then arrange them on the screen as they appeared when the view template was first created.

For example, if there were a couple of reports and a graph that were used on a regular basis, they could be arranged on the screen in any way desired, such as having the two reports side-by-side in the upper half of the window and the graph in the lower half. This arrangement constitutes a view and can be saved for future use on other data files.

The default view provides a template for data files when they are opened. The default view is indicated by a white checkmark on the icon.

To create a view, arrange the graphs and reports on the screen as desired. Click on the Tools menu, and then click Capture View. A new view icon will be created in the Graphs and Reports system folder.
Searching for Data

Locating data from hundreds of data files can be a difficult task. Use the **Find in Files** utility to search data files based on specific criteria:

Click on the **Edit** menu, and then click **Find in Files** to launch the search window:

![Find in Files](image)

In the example above, the search will look at data files that have recorder models “ViP” and “Eagle”, and that used the “100 A” current range, which occurred between 4/1/05 and 9/8/05. Click the **Find** button to begin the search.

The search criteria can be saved for future use by clicking on the **Save Query** button. Enter a name for the query, which will then be stored in the **Searches** folder.

The results of the search can also be saved by clicking on the **Save Result** button. Enter a name to label the results folder in which the found data files will be stored. This new folder will be located within the **Projects** system folder.

---

Importing Data Files

Data files that exist on the computer system are easily imported.

Click on the **File** menu, and then click **Import** to browse the system for the location of the data files:
For any location on the computer system chosen, all folders beneath it will be searched for data files, also.

### Viewing Real-Time Data

Real-time data capture is a powerful tool to view PQ data being measured “right now” by a recorder in a graphical and tabular format.

The **Waveform Graph** menu contains several graphs to present an overall view of the circuits being monitored.

The **Meter Display** menu contains several displays of tabular data to view numerical readings.

#### Waveform Graph

Five graphs are available for displaying real-time data:

- Voltage & Current Waveform
- Real Power Waveform
- phasor diagram
- Harmonic Graph (also known as harmonic bar graph or FFT Graph)
• Parametric Waveform

To access these graphs, ensure that the recorder is connected. Next, click on the Recorder menu and then click **Waveform Graph** to select one of the graphs.

![Real-time Voltage & Current Waveform](image1)

![Vector Diagram](image2)

![Harmonic Graph](image3)

![Parametric Waveform](image4)

**Meter Display**

Five displays of tabular data are available:

- **Main Readings**
- **IEC Flicker Readings**
- Harmonics, 1st – 8th
- Harmonics, 9th – 16th
- Diagnostics

To access these tables, ensure that the recorder is connected. Next, click on the **Recorder** menu and then click **Meter Display**.

**Note**

Not all PMI recorders are able to display real-time data. For real-time enabled recorders, the **Waveform Graph** and **Meter Display** menus will be enabled and available.
Customizing the Workspace

The ProVision™ application window is fully customizable to suit individual preferences.

- All toolbars and window panes may be moved and docked to other locations or may be left free floating anywhere on the desktop. They may also be hidden from view, if they’re not needed.

- Use the **View** menu to hide and unhide each of the window panes and status bar. Right-click in the toolbar area to hide and unhide each of the toolbars from the popup menu.

- Customize the toolbars from the popup menu to add or remove buttons or to lock the toolbars in place.

- When docked the window panes may be placed in **Auto Hide** mode by clicking on the pin icon located in the upper right corner of the pane.

- Use the full-screen mode to maximize the viewing area by clicking on the **View** menu, and then clicking on **Full Screen**.

Archiving Data

It may be necessary to remove old PQ data from the system. To do so, use the archiving feature to store project data files to any location. All archived data is fully recoverable.

To archive data, right click on the project folder to be archived, and then click **Create Archive** from the popup menu. Follow the wizard screens to complete the task.

To restore an archive, right-click on the **Projects** system folder, and then click **Restore Archive** from the popup menu. Then, browse to the location of the archive.

Scheduling Events

Events are useful to perform automated recorder operations at a specified time.

Click on the **Scheduler** menu, and then click **Add Event**.

The **Scheduler** window appears for creating a scheduled events with any number of recorders:
Start Time

Select the date and time to begin the event.

Action

Select one of two event types: Recording Download or Settings Upload.

- **Recording Download** will automatically download a PQ data recording from the recorder.

- **Settings Upload** will automatically upload recorder settings to the recorder.

Comment

Provide a comment to uniquely describe the event.

Recorders

The list of recorders to be included in the event.

Edit

Click this button to add or remove recorders from the list.

Save and Close
Stores the event and closes the window. The newly created event may be viewed and edited from the **Events** system folder in the **Devices** pane:

---

**Types of Records**

PMI recorders are able to record many different kinds of power quality data during a recording session.

**Interval Records**

The interval record is one of the most useful record types. In a single interval graph, power quality events can be seen such as single-cycle voltage sags and current surges, as well as long term voltage trends. With the graph, an entire recording session can be examined at a glance.

**What's Recorded**

The only setting for the interval record is the Recording Interval. This Interval, which can be as small as one second to as large as four hours, determines how often the Recorder takes a data point. Every interval record the Recorder is recording uses the same Interval setting. During the Interval period, the Recorder keeps a history of the largest and smallest one-cycle values for each interval record, as well as a running average. At the end of the Interval, the max, min, and average values for that time period are recorded as a data point. For example, if the Recording Interval is set to one minute (a typical setting), at the end of each minute, the Voltage Interval Record will record the average RMS voltage, the minimum one-cycle RMS voltage, and the maximum one-cycle RMS voltage, all during that minute. All of the 3,600 60Hz cycles during that minute are used to calculate the average, and for max/min detection.

These values are presented to the user as three traces on a graph: a maximum, a minimum, and an average. The average trace roughly corresponds to a graph from a paper stripchart recorder. The maximum and minimum graphs are unique, however. Each gives the worst case value for every Interval, with single-cycle measurement resolution.

Each Recorder has at least enough memory to record interval records for a week with a one minute Interval. When the interval record data fills the interval record memory, the Recorder has two options: it can either stop recording interval records, or go into "wrap-around" mode. In "wrap-around" mode, the oldest data points are erased to make room for the new ones as they are collected, which allows the Recorder to always have the latest data. This choice is made by
the user during the Initialization. If the **Interval Graph Overwrite (Circular)** box is checked, the Recorder will go into "wrap-around" mode as needed, otherwise it will stop recording when memory is full. This does not affect other record types. For example, if there is memory for one week of interval records, and the Recorder was left in the field for three weeks, it would either have the first or the last week's interval record data, depending on the wrap-around setting.

Every Recorder can record an interval record of voltage. Some Recorders can also record an interval record of current. The ViP can also record interval records for real, reactive, and apparent power, power factor, phase angle, THD, and harmonics. The ViP, with harmonics, can record over 200 interval records at once. Typically, only a few are needed at one time. All the interval records share the same memory, so enabling more interval records reduces the total interval record recording time.

When creating an interval graph or report, any "gaps" in the data due to a power outage are filled with zeroes. This happens when the Recorder loses power, and its rechargeable battery (if present) runs down.

**Typical Settings and Suggested Uses**

There are three settings for the interval record types. The primary setting is the Recording Interval. This time setting determines how often the data is recorded. Since the recordings always give worst case one-cycle max and min values, the Interval can be set to any time value without a loss of measurement resolution. For example, even if the Recording Interval is set to 15 minutes, the maximum and minimum one-cycle RMS values for each 15 minute period are recorded. What is lost by setting the Interval to larger values is time information. If there is a voltage minimum of 90 volts RMS during a recording interval, with the Interval set to 15 minutes, it’s certain that the voltage dipped that low for at least a cycle, but it’s not known when or how often or how long during those 15 minutes it happened. A smaller Interval, such as one minute, provides a finer time resolution. The smallest Interval, one second, gives excellent time resolution, but consumes memory 60 times faster than a one minute setting. Often, the exact time of a voltage dip is not as important as the size -- for this case, any reasonable Interval setting is fine.

The most common setting is one minute. This is a good balance between frequent data collection and long recording time. Since most loads that start and stop usually run for longer than a minute, the start and stop effects (such as in-rush current) are easily spotted in the Recording. An example is an air conditioner load: a forty minute period of cycling on and off is obvious in the interval graph as twenty data points at one load current, then twenty data points at low current, all connected by straight lines on the graph. The first interval of the high current period will probably have a much larger current maximum than the rest due to the starting current of the air conditioner. The voltage interval will probably have a dip at the same time.
The most frequent reason to use an Interval smaller than one minute is for large loads that cycle on and off more frequently than one minute. For example, if an elevator is causing power quality problems, and it only takes 10 or 20 seconds to start at one floor and stop at another, a one second Interval is probably necessary; otherwise the entire elevator travel will occur during a single Recording Interval. In this case, the Recorder should not be left to record for days, since it would only hold the last few hours of Interval data. The best use in this case is to set the Recording Interval to one second, then cycle the load (such as the elevator) for a while, in an attempt to reproduce the problem, and then download the Recorder. In general, the Interval should be smaller than the quickest cycling time of a problem load.

The most frequent reason to use an Interval larger than one minute is to increase the recording time. Setting the Interval to two minutes doubles the recording time, without a serious loss of time resolution. Other common settings are five and fifteen minutes, used to match metering or billing increments or regulatory time periods.

The second interval recording setting is the Interval Graph Overwrite mode. The best setting for this depends on how the Recorder will be used. Some users leave a Recorder at a problem site until the customer calls with a power quality complaint. The Recorder is set to a small Interval such as one minute or thirty seconds, and Overwrite is enabled. Because Overwrite is enabled, the interval records always have the latest few days of data in memory, by discarding the old data. The Recorder is downloaded, and has the most recent days of interval data in memory, no matter how long it was recording. This recent data will have the voltage disturbance in it. Other users will disable Overwrite, and leave a Recorder at a problem site where the power quality problem will definitely occur soon. The Recorder will record the first week or so of interval record data, then stop recording. The Recorder can be downloaded at any time later, knowing that the beginning of the recording session is locked in memory, and will not be overwritten. Other users always download the Recorder before it fills up interval record memory, which make the Overwrite setting irrelevant. The choice depends on how the Recorder will be used. The factory default setting is for Overwrite to be enabled.

The third interval record setting is which interval records are enabled. For voltage-only Recorders, there is no choice: a voltage interval record is always recorded. For Recorders that can record current, the current interval record can be turned off to extend the recording time of the voltage interval record. It is usually better to increase the Interval time instead of disabling current to get more recording time. For the ViP Recorder, there are many more interval records to enable or disable. The choice depends on what information is needed. If a power factor study is being performed, for example, turn on power factor, and possibly apparent power and displacement power factor. If a power quality problem is present, only voltage and current may be necessary, although adding Total Harmonic Distortion (THD) may be useful to see if harmonics are present. The total recording time is shown by ProVision™ as interval records are enabled and disabled during the Recorder setup. Another method to increase interval record memory is to reduce the number of recorded channels. If only three channels are needed on the ViP, changing the number of channels from four to three gives 25% more recording time.
For quantities such as power factor, phase angle, THD, etc., often the average is much more important than the one-cycle max and mins. The max and min traces on the graph may be turned off so that they don't obscure the average trace.

**Daily Profile Records**

The Daily Profiles are used to spot daily trends in voltage, current, power factor, etc. The entire recording session is combined to form the "average" 24-hour day, which is plotted on a graph like a stripchart. Power quality issues are usually not addressed with Daily Profiles (except perhaps consistently low or high line voltage or harmonic distortion). Rather, average line conditions such as regulation voltage, load current, etc. are profiled.

**What's Recorded**

Each measured quantity has only one Daily Profile per channel in a recording session. For example, there are four voltage Daily Profiles in a recording session, one per channel. The Profile is averaged over the entire recording session. This average is created by dividing the 24-hour day into 96 time periods, each 15 minutes long. During each 15 minute period, the Recorder computes the average value for that Profile (voltage, current, etc.). This 15 minute average is then averaged with all the previous days' averages of that 15 minute period. For example, the first Voltage Daily Profile data point is the average voltage during the 15 minute period from 12:00am to 12:15am, averaged again over the entire recording time. If a Recorder is recording for a week, then this 12:00-12:15am period is averaged seven times over the entire week.

There are no settings for Daily Profiles. All available Daily Profiles in a Recorder are always enabled, regardless of the settings for any other record types. Memory does not run out for a Daily Profile; it just keeps averaging as long as the recording session lasts (there is a practical limit of about a year). Some Recorders record just a voltage Profile, others voltage and current. The ViP Recorder records a Profile for voltage, current, real, reactive and apparent power, power factor, displacement power factor, voltage and current THD, and phase angle.

**Suggested Uses**

Daily Profiles are typically used to profile or characterize a parameter, such as average load current or power factor. Since the Profile is supposed to reflect average line conditions, the more loads included in the recording, the better the average. Monitoring a single small load such as a small office building would not create a very good profile of distribution line conditions (such as distribution line power factor), since the building would be a small part of the total distribution load. Voltage is somewhat of an exception in that anywhere can be good place to create a profile: every other load (at least those nearby) will see the same distribution.
line voltage. The ideal location for creating power factor profiles is where a PFC would be placed to correct power factor.

The voltage Daily Profile is normally used to identify voltage regulation problems, or other steady-state low/high voltage issues. The current Profile can be used to identify daily trends in load current. This is also possible with the apparent power Profile. Power factor and reactive power Profiles can be used to set PFC timers to correct for power factor only when necessary during the day. The voltage and current THD Profiles show when harmonic distortion is present during the day.

The more days the Recorder records, the better the average created by the Profile. A recording session that just lasts a single day doesn't incorporate any daily averaging at all. Since a Profile starts with all zeros, a recording session that doesn't even last 24 hours will include some 15 minute blocks with the data still zeroed. A recording session that doesn't even last 15 minutes will have all zeroes for a Daily Profile.

An interval recording can also be used for profiling tasks, but is not ideal. The recording interval is usually set to an interval faster than 15 minutes; a fast interval can show too much information, making it hard to form a good average Profile. Often the interval recording only has enough memory for a week or two, limiting the averaging time; the Daily Profiles have no such limit. Most importantly, the interval recording does not divide the data into an averaged day period, so it can be difficult to spot daily trends in the graph.

**Cycle Histogram Records**

The cycle histograms contain valuable power quality information as well as information for distribution line profiling. Questions such as "what was the absolute highest and lowest RMS voltage?", "how many cycles was the voltage below 80 volts?", and "what are the most common load currents?" are easily answered. The histograms also contain the raw data necessary to answer more complicated statistical questions such as "what is the probability of a voltage sag below 100 volts?" and "what high and low limits does the line voltage meet 99.99% of the time?" Where the Daily Profiles give average current, power factor, etc. for distribution profiling, the histograms show what values are the most common -- the "mode" in statistical terms.

**What's Recorded**

A Histogram divides a measurement range into many bins. For example, in the ViP, the voltage Histogram divides the 600V voltage range into 600 bins, each one volt wide, giving a bin for zero volts, a bin for one volt, two volts, all the way to 600 volts. After each 60Hz cycle is measured, the voltage is rounded to the nearest volt and "put" in the appropriate bin. The bins are really counters that count how many cycles were at that voltage. If the 108 volt bin has a
count of 45, then there have been 45 cycles with an RMS voltage of exactly 108 volts, sometime during the recording session. The Histogram throws away time information: those 45 cycles could have occurred anytime during the recording session. They may have been 45 cycles in a row, or three 15-cycle sags, or 45 isolated sags spread out during the entire recording session. (To recover the time information, use the interval graph or an event-based report.)

Every interval graph max and min value will have a non-zero count in the corresponding Histogram. For example, if the voltage interval graph shows six sags to 108 volts sometime during the recording session, there should be a count of at least six in the Histogram at 108 volts. The count will probably be somewhat larger, unless each sag was only one cycle long.

There are no settings for Histograms. All available Histograms in a Recorder are always enabled, regardless of the settings for any other record types. Memory does not run out for a Histogram; it just keeps classifying measurements into the bins (by incrementing the bin counters) as long as the recording session lasts.

The 600V (iVS-3/600), the S-series (VS-1S and iVS-1S), and the ViP record a voltage cycle Histogram for each voltage channel. The ViP also records cycle Histograms of current, real, reactive, and apparent power, power factor, displacement power factor, and phase angle.

**Suggested Uses**

The power of the Histogram is that *every cycle* is included in the report. Every cycle during the recording session is reflected in the count of one of the bins. If all the counts in a Histogram are totaled, the result is how many cycles the recording session lasted (minus any time under a power outage).

Histograms are presented as a bar graph and a report. The report is in some ways easier to read than the graph. The absolute highest and lowest voltages during the recording session are found by finding the highest and lowest bins with a non-zero count. At that point it’s known how many cycles the voltage was at those extremes, and by glancing at the nearby bins, it’s also known how many cycles the voltage was near those extremes. For example, if all the bins below 110 volts are zero, then it’s immediately known that there was not even a single cycle of voltage below 110 volts anytime during the recording session. If the count at 111 volts is 1,352,200, then the voltage was at 111 volts for over 6 hours (1,352,200 = (60 X 60 X 60)). By totaling the counts for all the bins in a voltage range (for example, 0 to 90 volts), it’s known how many cycles the voltage was in that range.

More complicated power quality questions can be answered by exporting the histogram data to a spreadsheet. By dividing each count by the total of all the counts, the histogram data is normalized, and can represent a sample probability distribution function. If a normal, or bell-shaped probability distribution is fit to this data, a standard deviation is created that can be used to answer "what high and low limits does the line voltage meet 99.99% of the time?". A
cumulative sum over the data will convert the distribution function into a sample cumulative probability function. Correlations between channels can be performed by comparing the probability functions of channels.

For the voltage histogram, most of the time the user is interested in the few cycles that are outside certain limits, not the vast majority of cycles that are perfectly normal. These few cycles usually represent power quality issues. The current, power, and power factor histograms are useful for distribution line or load profiling. For these histograms, the few cycles at the extremes are usually unimportant: the vast majority in the middle is the good data.

**Minute Histogram Records**

The Minute Histogram provides a much "smoother" version of the Cycle Histogram. Quick sags and swells are averaged out of the data, to show the nominal voltage or current level every minute. Voltage regulation problems are easy to see in the Minute Histogram.

**What's Recorded**

The Minute Histogram is similar to the Cycle Histogram. During each minute of the recording session, the voltage is averaged (every cycle is included). At the end of the minute, the Histogram bin counter for that average value is incremented. The result is a Histogram of one minute average voltages, instead of one cycle voltages. For example, if the voltage were 123 volts for 55 seconds, then 115 volts for 5 seconds, the average would be 122 volts, and the 122 volt bin counter would be incremented. If the recording interval is also set to one minute, then the Interval graph voltage averages will match the Minute Histogram counts.

Like the Cycle Histograms, there are no settings for the Minute Histogram. All available Minute Histograms in a Recorder are always recorded, regardless of the settings for any other record types. Memory does not run out for a Minute Histogram; it just keeps classifying measurements into the bins (by incrementing the bin counters) as long as the recording session lasts. All Recorders record a voltage Minute Histogram. Recorders that can measure current also record a current Minute Histogram.

**Suggested Uses**

The voltage Minute Histogram can reveal voltage regulation problems. Ideally, the line voltage should be at the same value every minute. The larger the spread in the Minute Histogram, the more the voltage is varying. The center of the spread is (hopefully) the target regulation voltage. This information is also present to an extent in the voltage Interval graph, depending on the recording interval and amount of memory. Because the Interval graph spreads out the voltage averages as a time graph, it can be more difficult to gauge how long the voltage was at certain levels (although it may be easier to see why the voltage was moving).
The Minute Histogram is also better for this analysis because it does not run out of memory, and is always set for one minute averaging.

The current Minute Histogram shows average load current on a minute basis. The maximum and average load currents are easily spotted on the Histogram as the edge and the center of the current spread. Again, this information is usually in the current Interval graph, but not as easy to see.

The cycle Histograms can also be used for voltage regulation problems and load profiling, but the Minute Histograms can be easier to read since the fast one-cycle events have been averaged out.

**Energy Usage Records**

The Energy Usage report shows the accumulated real, reactive, and apparent power measured by the Recorder. The accumulated real power is energy, in kilowatt-hours. The accumulated reactive and apparent powers are kilovar-hours and kilovolt-amp-hours, respectively. These totals are for the entire recording session, and are only available on Recorders which can compute power.

**What's Recorded**

Each cycle, the real, reactive, and apparent power values are computed and added to the running totals for the recording session. These values include the effects of voltage and current harmonics. The accumulated powers are totaled separately for each channel for a wye hookup. With a delta hookup, the individual phase powers cannot be measured, only the total. In this case, the three phase total real, reactive, and apparent power values are totaled and reported.

Negative power values are included in the accumulation. For example, if a load is both absorbing and generating power (at different times, of course), the accumulated power will reflect it. A line that varies from leading to lagging power factor may have a small accumulated reactive power reading, even though at different times the actual reactive power flow was large. This would happen if the negative VARs accumulated during the periods of leading power factor mostly cancelled the positive VARs during the periods of lagging power factor.

**Typical Settings and Suggested Uses**

There are no settings for the Energy Usage report. This report can be used to measure energy consumption of a monitored load, or accumulated reactive power in power factor studies. A revenue meter that doesn't total negative power, or doesn't include the effects of harmonics, may show readings that differ from this report.
Significant Change Records

The Significant Change record type tracks quick fluctuations in the line voltage, with single-cycle response, while ignoring gradual changes. Voltage events are timestamped to the second, and listed in a report. If the report is empty, there were no voltage events that exceeded the trigger threshold. This is a quick way to gauge the voltage power quality, because only voltage fluctuations exceeding the threshold are listed.

Trigger Logic

The Significant Change record type uses a voltage threshold parameter. At the end of each second during the recording session, the largest and smallest RMS voltages for that second are compared with the "standard" Significant Change voltage. This standard voltage starts as the nominal voltage picked by the Recorder during the two minute countdown (typically 120, 208, 240, 277, or 480 volts). If the difference between the standard voltage and either the maximum or minimum voltage was more than the threshold, a Significant Change is recorded. In addition, the voltage (either the max or min) that caused the trigger becomes the new "standard" until the next Significant Change.

As an example, consider a "standard" voltage of 119 volts, and a threshold of 2 volts. After 40 seconds, the voltage drops to 118 volts. No Significant Change is recorded because the 1 volt change is smaller than the 2 volt threshold. After another 35 seconds the voltage increases to 120 volts. The change is 2 volts, from 118 to 120, but no Significant Change occurs because 120 volts is only 1 volt greater than the "standard" of 119. After another 23 seconds the voltage increases to 121 volts. A Significant Change is triggered because the 1 volt increase created a 2 volt difference between the 121 maximum voltage for that second, and the 119 volt standard. The standard voltage is now set to 121 volts, until the next Significant Change.

Only one Significant Change per second can be recorded per channel. If both the single-cycle max and min meet the threshold in the same second, the voltage that is furthest from the standard becomes the new standard.

What’s Recorded

When a Significant Change is triggered, the triggering voltage is recorded, along with a date and timestamp (to the second), and the channel number.

Significant Change is recorded separately for each voltage channel (although they share the same voltage threshold parameter). If Significant Change memory is filled, Significant Change recording stops. All voltage channels use the same Significant Change memory. The amount of memory used for Significant Change is different for various Recorders, but every Recorder can record hundreds, and most over one thousand records.
On most Recorders, Significant Change is always enabled for recording. On some older Recorders, enabling Flicker recording disables Significant Change recording. This is true for the VP-1, and 300 volts Recorders (the VS-3, VS-1, VS-1M, iVS-3, iVS-1, and iVS-1M) with serial numbers below 6000.

Typical Settings and Suggested Uses

The default setting for the Significant Change threshold is 3 volts. This setting can be as small as 1 volt or as large as 8 volts. Normally, a threshold between 2 and 5 volts is appropriate, depending on the nominal voltage. A single-cycle disturbance such as a sag will trigger Significant Change if the sag is greater than the threshold. If this happens, the sag voltage becomes the standard, which will trigger another Significant Change if the voltage returns its previous level.

The Significant Change report is very useful for determining how often, and to what degree the line voltage is fluctuating. If there are no Significant Change records, then there were no fluctuations greater than the threshold. A Significant Change record can be correlated with the Interval record by using its timestamp. Find the same time period in the Interval record to see what the voltage and current were before and after. This may give some indication of the cause of the disturbance. All Significant Change records during a recording interval will be included in a single Interval record max/min/average data point. For example, if the interval is one minute, and six Significant Changes occur within one minute, they may all fall into the same Interval record data point. (Of course they are still reported individually in the Significant Change report). The Significant Change report provides more detail than the Interval record for these disturbances.

A key advantage of the Significant Change report is that only one disturbance per channel can be triggered each second. If multiple disturbances occur during a second, the worst one is recorded. This limits the size of the report, making it much easier to analyze, while still giving single-cycle response. If detailed disturbance information on a cycle basis is required, use the Event Change report. Event Change gives much more detail, but is more complicated to examine. The timestamp of a Significant Change event can be used to find the same disturbance in the Event Change report for further analysis.

For even more detail, Waveform Capture can be used (if available). If the disturbance triggered Waveform Capture, the raw waveforms of each voltage and current channel can be displayed. Again, the Significant timestamp is used to find the waveform in the list of captured waveforms.
Event Change Records

The Event Change report provides detailed cycle-level information about each voltage disturbance. This is the most detailed report available short of actually looking at raw waveforms with Waveform Capture. An event is triggered when the voltage moves past any of a series of trip points. Max and min voltages and currents during the event, the event duration (in cycles), and the current before and after the event are all recorded.

Trigger Logic

Event Change triggering involves three parameters. The first, the Nominal voltage, sets a baseline voltage level. This is not the same nominal voltage selected by the Abnormal Voltage record type during the two minute countdown. The Event Change Nominal voltage is specified by the user, and is not picked by the Recorder. The second parameter is the Threshold, in volts. The Threshold is added and subtracted to the Nominal to form voltage trip points. These trip points are created all the way down to zero volts and up to the maximum Recorder voltage by using multiples of the Threshold. For example, a Nominal of 120 and a Threshold of 6 would create trip points at $120 \pm 6 = 114, 126; 120 \pm 2 \times 6 = 108, 132; 120 \pm 3 \times 6 = 102, 138; \text{ etc.}$

The voltage region around the Nominal, but before any trip points (115 to 125 volts in the above example) is the Nominal Band. If the voltage moves from the Nominal Band to cross a trip point, an Event Change is triggered. This Event Change continues until the voltage either returns back into the Nominal Band, or moves past another trip point. Each time the voltage moves past another trip point, the existing Event Change ends and a new Event Change is triggered. The trip points can be visualized as a grid (every 6 volts in the above example) from zero volts to the maximum Recorder voltage, and any time the line voltage crosses a grid line, an Event Change is triggered.

There is one exception to the previous paragraph. The third setting, Holdoff Time, specifies in cycles how long to wait before allowing a new Event Change, if the voltage continues moving in the same direction. This setting is to prevent a slow sag from generating multiple Event Changes. For example, consider a Nominal of 120, a Threshold of 6, and a Holdoff Time of 10 cycles. The line voltage is 119 volts, and no Event Change has been triggered. Now a slow sag occurs. The voltage drops to 114 volts, triggering an Event Change. The next cycle, the voltage keeps dropping to 110 volts. On the third cycle, the voltage drops to 105 volts. This would normally cause the Event Change to end and a new one to be triggered, since the voltage crossed another trip point. However, with the Holdoff Time set to 10 cycles, no new Event Changes can be triggered for 10 cycles, as long as the voltage continues to drop. If the voltage changed direction and started to rise, then the Holdoff Time would not apply -- if the voltage rose past a trip point, the existing Event Change would end and a new one would start. The Holdoff Time doesn't prevent Event Change from capturing short events, but keeps a slow voltage change from generating multiple events.
Event Change can be triggered by any voltage channel. The triggering logic (and settings) is separate for each channel. Another channel may trigger its own Event Change while other channels have running Events, resulting in overlapping Events.

**What's Recorded**

When an Event Change is triggered, the trigger time is recorded, with one cycle resolution. The RMS current one cycle before the trigger is recorded. The direction of the voltage change, or slope, is also recorded. This is displayed in ProVision™ as a minus for a sag and a plus for a swell. While the event is occurring, the Recorder keeps track of the max and min current and voltage values. When the event ends, the max and min RMS voltage and currents are recorded, along with the duration (in cycles). One cycle later, the RMS currents are measured to record the currents after the event.

All voltage and current measurements are recorded for every channel, regardless of which channel triggered the event. If a sag occurs on three phases simultaneously, three Events will be triggered at the same time. These Events are recorded separately, even though they may have the same data in them.

**Typical Settings and Suggested Uses**

The Nominal voltage should be set as close as possible to the actual nominal line voltage. If a circuit normally runs at about 117 volts, use 117 as the Nominal, not 120. Event Change is not for steady-state line voltage regulation problems (like the Abnormal Voltage report), but for quick sags and swells. The Threshold should be set small enough to catch problem events, but large enough to avoid filling up memory with unimportant data. A good start is 5% of the Nominal. The Nominal and Threshold can be set separately for each channel. These should be set accordingly if some channels see different voltage levels (for example, in a single phase setting where two channels are connected line to ground, and the third channel line to line.) To effectively disable Event Change on a channel, set its Threshold to something huge, like 500 volts.

The Holdoff Time is not as critical. Ideally, this is set to just larger than the slowest anticipated sag time. For example, if no sags (such as from motor starts, etc.) will take longer than 6 cycles for the voltage to drop to the sag value, the best Holdoff Time is 7 cycles. This will prevent multiple Events Changes from the same voltage sag. Otherwise, as the voltage dropped lower and lower, past voltage trip points, Events would continue to be triggered. Ideally, only one Event is triggered for a single sag or swell. A typical value is 10 cycles. This is longer than most sags take to reach the final sag voltage.

Event Change provides cycle-level detail on sags and swells. A sag which merely shows up as a single point on the Interval record can be analyzed in the Event Change report. Usually, Event Change is not the first report to analyze in a recording, due to its complexity. Check the
voltage Interval record for min or max voltages out of tolerance, or the Significant Change report for voltage fluctuations. If a disturbance needs further study, use the timestamp to find the fluctuation in the Event Change report. Here detailed information such as cycle duration, pre- and post-event RMS currents, etc. is available.

The most useful values are the duration and max and min voltages. This information shows how long the event lasted, and how low or high the voltage went. The cycle timestamp can be useful to determine how far apart several events were which occurred in the same second. The timestamp is also used to correlate an Event Change with other reports, such as Significant Change and Waveform Capture.

The pre- and post- RMS current can be used to determine whether the load being monitored caused a sag. Consider a sag that triggers an Event Change. If the current one cycle before the event is low, but the max current during the event is high, and the current one cycle after is high (or at least higher than the pre-trigger current), the monitored load probably caused the event. In-rush current from a motor start will cause this type of pattern: the high in-rush current pulls the voltage down, triggering an event. When the in-rush current peak is over, the voltage goes back up, ending the event. The final current is lower than the in-rush current, but higher than the current before the event.

Another possibility is a voltage sag where the current during the event is lower than the pre-trigger current (or about the same), and the post-trigger current is about the same. Here, the monitored load probably did not cause the event. Some other load pulled the voltage down, and the monitored load current dropped proportionately with the lowered voltage. When the voltage came back up, the current rose to its normal level also.

ProVision™ groups closely occurring Event Change records into super-events. A super-event is started when an Event starts on any channel. The super-event lasts until there are no running Events on all channels for at least an entire second. A complicated voltage disturbance may trigger several closely spaced or back-to-back Event Changes, but will be grouped into a single super-event for easier analysis.

Event Change is recorded separately for each voltage channel. If Event Change memory is filled, Event Change recording stops. All voltage channels use the same Event Change memory. The amount of memory used for Event Change is different for various Recorders, but every Recorder with Event Change can record hundreds, and most over one thousand records.

**Power Outage Records**

The Power Outage report lists the date and time of all outages during the recording session. An outage is defined by the Recorder to be a voltage sag below 80 volts, lasting for at least 1/3 of a second. Only channel one's voltage is used to trigger an outage. The beginning and end of the
outage are timestamped. In the report, the duration is also given, along with the total number of
outages and the total outage time.

If the Recorder has battery ride-through capability, it will continue to record Histograms,
Interval records, etc. during the outage. If there is no battery, or if the battery runs down, the
Recorder loses power and stops recording. When power is restored, the Recorder records the
end of that power outage and resumes recording normally.

A power outage often triggers Waveform Capture, which may help reveal the cause of the
outage.

Flicker Records

The Flicker record type is designed to show voltage variations that cause lights to flicker. The
Recorder defaults to the threshold of irritation curve from IEEE Standard 141. This curve is
designed to show only voltage flicker that is perceived as irritating. When this occurs, a flicker
event is recorded with the time and magnitude.

Trigger Logic

A Flicker curve is specified by a list of allowable voltage thresholds, and a limit on their
quantity in certain time spans. The default curve allows 5 voltage fluctuations of 1% or greater,
in a ten second period; 10 fluctuations of 1.5% or greater, in a one minute period, and so on up
to 10 fluctuations of 6% or greater, in a 24 hour period. In general, the larger the voltage
variation, the less often it is allowed before triggering a Flicker record. There are nine pre-set
time periods used, from 10 seconds to 24 hours. Each has an adjustable threshold percentage
and event limit. If the voltage variations exceed the threshold percentage more than the number
of times allowed by the limit, in a certain time period, then a Flicker record is triggered.

For example, with the default settings, if the voltage varies more than 1% over 5 times in a ten
second period, a Flicker record is generated. These variations also count for the longer Flicker
time spans if they are large enough.

Flicker is computed once per second, based on the previous second's one-cycle max, min, and
one second average RMS voltage levels. The thresholds are given as a percentage. If the max,
min or average differs from each other by more than the percentage for a certain time period,
then a flicker event counter is incremented. If the counter value exceeds the limit for a certain
time period, a Flicker record is triggered.

Flicker is triggered separately for each voltage channel.
What's Recorded

When a Flicker record is created, the date and time are recorded, along with the number of voltage events that exceeded the tolerance. The time span over which the flicker occurred is also recorded. Each channel is reported separately.

Typical Settings and Suggested Uses

The Flicker report is designed to show whether utility customers will perceive voltage variations as flickering lights. The default curve is programmed to generate Flicker events when a person would become irritated by the level of Flicker. The IEEE also has a curve which shows when a person would just perceive flickering lights, but not become irritated. The validity of these curves depends on individual circumstances such as lighting (the curves assume 120V incandescent) and customer sensitivity.

The Flicker report is used both to confirm a customer complaint about flickering lights, and to measure progress in mitigating a problem. If no Flicker events were recorded, then no voltage variations occurred which exceeded the allowed limits, and the problem may have been solved. Since flickering light perception is so subjective, merely showing a customer a Flicker report which shows no flicker according to a standard curve may lessen the complaint by showing that the voltage variations are within standard limits.

Flicker is recorded separately for each voltage channel. If Flicker memory is filled, Flicker recording stops. All voltage channels use the same Flicker memory. The amount of memory used for Flicker is different for various Recorders, but every Recorder with Flicker can record hundreds, and most over one thousand records.

It is important to connect any unused voltage clip leads together, or in parallel with another voltage channel, to avoid generating bogus Flicker records. The threshold parameter is a percent change value, and applying a small percentage to an already small voltage creates tiny thresholds that are constantly exceeded. Flicker is not meaningful on neutral to ground voltage channels: only channels that are used to power lighting generate meaningful Flicker data.

On most Recorders, Flicker is always enabled for recording. On some older Recorders, enabling Significant Change recording disables Flicker recording. This is true for the VP-1, and 300 volts Recorders (the VS-3, VS-1, VS-1M, iVS-3, iVS-1, and iVS-1M) with serial numbers below 6000.

Abnormal Voltage Records

The Abnormal Voltage record type shows if the average line voltage moved past a low or high threshold from the nominal voltage. On some Recorders, the low threshold exceedence is indicated by a green LED on the front panel, and the high threshold exceedence by a red LED.
When the trigger occurs, the event is timestamped to the nearest second. There is a separate LED and report for each voltage channel.

**Trigger Logic**

The triggering logic uses a low and high threshold, a nominal voltage, and a trigger duration. The thresholds are added and subtracted to the nominal voltage to find triggering points. If the voltage crosses a triggering point for longer than the trigger duration, an Abnormal Voltage event occurs.

The Recorder is initialized with a list of potential nominal voltages (such as 120, 240, etc.), with low and high voltage thresholds for each. The actual nominal is picked by the Recorder during the two minute countdown. The average voltage during the countdown is compared to each of the nominals; the closest one becomes the nominal voltage for the entire recording session.

There are five standard nominals in the software setup (120, 208, 240, 277, and 480 volts), and two custom nominals. The custom nominals can be set to any voltage. It is possible to enable and disable the standard and custom nominals. For example, if it’s desired to force the Recorder to use 230 volts as the nominal, the standard nominals should be disabled, and both custom nominals set to 230. If the standard nominals were not disabled, there would be a chance for the Recorder to pick 240 volts during the two minute countdown, if the line voltage happened to be running closer to 240 than 230 at that time. The nominal is chosen by the Recorder separately for each voltage channel.

There are separate high and low thresholds for each of the seven nominal voltages. The applicable thresholds are used once a nominal is selected by the Recorder after the two minute countdown. Voltage channels are handled separately; there is a complete set of nominals and thresholds for each. This is useful for situations such as a hot-leg delta, where one voltage channel is at a different voltage, or in a single phase setup where two channels are connected line-to-neutral, and one channel is line-to-line. The Recorder will automatically select the correct nominal and thresholds for the different line voltages on each channel.

The last Abnormal Voltage parameter is a trigger duration, in seconds. This specifies how many seconds in a row the voltage must exceed the threshold before the Abnormal Voltage record is triggered.

At the end of each second during the recording session, the Recorder compares the one-second average voltage with the nominal and the low and high thresholds. Each threshold actually creates two trip points, one above the nominal and one below. For example, consider a setup where the nominal is 120 volts, the low threshold is 6, and the high 12. The low trip points become 120 ± 6, or 114 and 126 volts. The high trip points are 120 ± 12, or 108 and 132 volts. If the one-second average voltage rises above 126 or falls below 114 volts for longer than the trigger duration, the low Abnormal Voltage trigger occurs. This event is timestamped, and the green LED is lit (if present). If the voltage goes past either high trigger point (108 or 132 volts)
for longer than the trigger duration, the high Abnormal Voltage trigger fires. This is
timestamped, and the red LED is lit (if present). It is possible for the low and high triggers to
fire at the same time.

The use of one-second average voltages eliminates false triggering due to momentary sags and
swells. Abnormal Voltage is designed to trigger for average line voltage exceptions, not sub-
second events.

Once an LED indicator is lit due to an Abnormal Voltage trigger, it stays on for the rest of the
recording session, even if the voltage returns to the nominal. The LED indication of an
Abnormal voltage trigger can be disabled through the software. The event is still recorded
normally, but no LEDs are lit.

**What's Recorded**

When Abnormal Voltage is triggered, the date and time, along with the channel and triggering
voltage are recorded. There is a separate listing for each voltage channel, as well as low and
high thresholds. Only the first trigger for each threshold is recorded.

**Typical Settings and Suggested Uses**

The Abnormal Voltage report is used to determine whether the voltage drifted outside the
thresholds during the recording session. Since the LED indicators stay lit after a trigger, they
can be used to see at a glance whether a Recorder needs to be downloaded due to line voltage
problems. Usually the Abnormal Voltage report is used to get a quick read of whether there
was any line voltage drift -- if so, then other record types such as the Interval record and
Significant Change are used for more information.

The default threshold settings are at 5% and 10% of the nominal voltage (for example, 6 and 12
volts for the 120 volt nominal). The high threshold must be larger than the low threshold. The
two custom nominals are preset at 106 and 230 volts, but should be changed if a different
nominal is in use. The default trigger duration is five seconds, and can be set as small as one
second, or as large as 255 seconds.

**Loose Neutral Records**

The Loose Neutral report shows whether the typical symptoms of a loose neutral have occurred.
This report is intended for single phase services, with voltage channels one and two connected
from line to neutral. Only a two-channel Recorder, or a Recorder set to use two channels, can
record a Loose Neutral. The symptom of a loose neutral condition is for one voltage leg to rise
in voltage, and the other to fall, with the sum of the two voltages remaining close to twice the
nominal voltage. For example, if the voltages start at 119 and 121 volts, then move to 105 and
135 volts, a loose neutral is a likely cause: one leg went up, one went down, and the sum is close to twice the nominal (240 volts).

This happens when the load is not balanced, and the neutral is disconnected. If this condition is met for long enough, the Loose Neutral report is triggered.

**Trigger Logic**

The Loose Neutral logic uses three parameters: duration, range, and difference. These parameters are used to judge whether one voltage leg has risen, and one fallen, while the sum remained the same. The difference is a voltage that specifies the minimum difference between the two legs. For example, if the difference is 16 volts, then there must be at least a 16 volt separation between the two legs. The range is a voltage that specifies how close the sum of the two voltages must be to twice the nominal. For example, a range of 12 volts means that the sum of the two legs must be within 12 volts of twice the nominal voltage. Both the range and the difference conditions must be met for at least the number of seconds specified by the duration. If the duration is set to 5 seconds, then the difference and range conditions must be met for 5 consecutive seconds before a loose neutral is declared. One-second average voltages are used. The nominal voltage is the nominal determined during the two minute countdown by the Abnormal Voltage record type, and is typically 120 volts in a single-phase hookup.

As an example, assume the difference parameter is 16 volts, and the range 12 volts, with a duration of 5 seconds. The two line voltages are 119 and 121 volts. Then one leg moves to 128 volts, and the other to 110 volts. The difference between the two legs is 18 volts, which meets the difference threshold. The sum of the two voltages is 238 volts, which is within the required 12 volts (specified by the range value) of twice the nominal voltage (240 volts). If these voltages persist for 5 seconds in a row, then a Loose Neutral record will be triggered.

If one voltage leg changes due to heavy loading, the range parameter keeps the loose neutral from false triggering. For example, if the voltages start at 119 and 121 volts, then a heavy load to channel 1 causes it to drop to 105 volts, with the other leg still at 121, the difference condition is met (121 - 105 > 12), but the range condition is not met: 105 + 121 = 226, and 226 volts is not within 12 volts of the 240 volt nominal.

**What’s Recorded**

The date and time of the loose neutral triggering is recorded, along with the voltage on the two channels. Only the first occurrence of a Loose Neutral is recorded; if the conditions are met again, nothing further happens. The Loose Neutral report shows whether the neutral may have a bad connection, not the exact times the connection was made and broken.
**Typical Settings and Suggested Uses**

The Loose Neutral Report can show the *symptoms* of an actual loose neutral connection. It is worth investigating if the report is triggered. However, it is possible for the Loose Neutral logic to be fooled. If both legs are equally loaded, then the two voltages will remain the same even if the neutral is removed. This will prevent the Loose Neutral trigger from firing. It is also possible for one leg to rise and one to fall due to grossly different loading, and not from an actual loose connection. Thus it is possible for a Loose Neutral to trigger falsely, when there is no loose connection.

**Waveform Capture Records**

Waveform Capture provides the most detailed report possible: the raw voltage and current waveforms themselves are recorded. With clues provided by the waveform shapes, it is sometimes possible to determine the cause of a voltage disturbance. Events such as capacitors opening and closing, reclosers operating, and lightning strikes can sometimes produce distinctive shapes. The voltage waveforms also reveal the exact duration and magnitude of an event, and how much was coupled across phases. Waveform Capture is also useful during steady-state conditions. The current wave shapes can show harmonic currents from non-linear loads, and the voltage wave shapes show the distortion due to harmonic currents and transformer loading. It takes a huge amount of memory to store raw waveforms. The memory size of a single 3-cycle Waveform Capture record is larger than the size of four hours of Interval data (at one minute intervals).

**Trigger Logic**

Waveform Capture uses a single threshold for triggering. This threshold is a percentage. At the end of each 60Hz cycle, the RMS voltage for that cycle is compared with the RMS voltage of the previous cycle. If the percent change in RMS value is greater than the threshold, Waveform Capture is triggered. Any voltage channel can trigger waveform capture. The voltage must be at least 5 volts to trigger. If a trigger occurs, the waveform data is recorded. The trigger test is repeated every cycle, so if the RMS voltage keeps changing, Waveform Capture will continue to be triggered, until the voltage stabilizes.

Waveform Capture can be triggered manually from the front panel of the Recorder. This produces a three cycle Capture.

If a Waveform Capture trigger doesn't occur at all during a recording session, a one cycle Capture is still recorded. This waveform is taken at the very end of the session.
What's Recorded

When a trigger occurs, the waveform data for the triggering cycle is recorded, along with the date and time (to the nearest cycle). The waveform data for the previous cycle is also recorded, to provide a pre-trigger waveform. All voltage and current wave shapes are recorded, regardless of which channel caused the trigger. The waveforms of the next cycle are also recorded, to provide a post-trigger waveform. This creates a three cycle Waveform Capture record. If the trigger condition is met again on the next cycle, then an additional cycle of waveforms is added. In general, the Waveform Capture record continues until one cycle after the triggering stops. If the voltage is fluctuating wildly, the entire Waveform Capture memory could be filled by a very long Waveform Capture record. If the Waveform Capture memory is full before the end of the event, the Recorder erases cycles of the earliest record to make room for the new data.

The waveform data is presented as a graph and a report. The report is usually used only if the data will be exported to a spreadsheet.

Typical Settings and Suggested Uses

The default setting is 2%. With this threshold, the RMS voltage has to change by at least 2% in a single cycle. If the threshold is too tight, Waveform Capture will trigger so often that useless events overwrite the important waveforms. A Waveform Capture report consisting of just one very long record is an indication that the setting is too small. A report where all the waveform records occurred during the last few minutes of the recording session is another indicator of too small a threshold. In both these cases, the trigger was being met too often. Of course, if no waveform records are present, either the threshold was too large, or the voltage quality was too good. The optimal setting varies from system to system.

The exact nature of a voltage disturbance can be seen in the Waveform Capture report. The peak voltage, length of the sag or swell, and the coupling from phase to phase are easily seen in the graph. Sometimes there are clues regarding the cause of a voltage disturbance. A voltage sag that starts in the middle of a cycle but ends at a zero-crossing can be produced by a gas arrestor. The arc continues until the voltage reaches zero, then the arc is extinguished. A recloser operation usually begins and ends at random points in the cycle. A voltage sag that is preceded by an increase in current, but followed by a decrease in current, is usually caused by the monitored load. If the current went down during the sag, and was steady before and after, the sag was probably not caused by the monitored load.

Each triggered event is often captured by the Significant Change and Event Change reports. The min or max voltage is usually in the Interval record as well. These reports can be used to place the Waveform Capture record into the proper overall context. Use the timestamps for each record type to correlate the different reports.
A manual trigger captures the voltage and current waveforms during steady-state conditions (unless the user happened to press the button at the exact moment of a disturbance). Transformer saturation often shows in a flattened voltage wave shape. If the positive voltage half-cycle is a different shape than the negative half-cycle, even-order voltage harmonics are present. Often the current waveforms will not be sinusoidal. The less they look like a sine wave, the higher the level of current harmonics. Frequently, the neutral current looks much less sinusoidal than the line currents, due to the fact that some harmonics don't cancel out in a three phase system, even with a balanced load. The more the current waveform is shifted from the voltage waveform, the worse the power factor.

It is important to provide a clean ending to a recording session when using Waveform Capture. If the Recorder is still recording while the voltage leads are disconnected from the line, several Waveform Capture records will be recorded as the voltage drops to zero on each channel. These useless records of the voltage leads being disconnected can overwrite the valuable recorded data. If the Recorder will be downloaded in the field, a serial cable can be connected with the voltage leads still attached. The Recorder will detect the cable and stop recording cleanly. Otherwise, the front panel menus should be used to bring up the "STOP" option. Selecting this option stops the recording session cleanly. The voltage leads can then be removed.
Additional Resources

Understanding Recorder Records

This seminal document, describing the records that PMI recorders can store, is available in PDF format.

This and other helpful documents may be found on the ProVision™ installation CD.

Technical Support

Help is always available if additional assistance is needed. Use one of the following methods to obtain technical support:

E-mail Support

Send e-mail to: support@powermonitors.com.

Web Support

Submit a Support Request via the Web at http://www.powermonitors.com/support.html.

Telephone Support

Contact us 24 hours a day, 7 days a week for live tech support by calling:

(800) 296-4120

Faxes should be sent to:

(540) 432-9430

Postal Mail Support

All correspondence by post should be addressed to:

Power Monitors, Inc
1661 Virginia Avenue
Harrisonburg, VA 22802
Glossary of Terms

Activate

To make a data file active. (An active data file will have a checkmark next to its name in the Explorer.)

Active

The state in which a data file may be used to perform user actions, e.g. creating graphs and reports.

Data File

A file containing recorder data.

Graph Template

A blank form in which graphical data can be inserted to create a custom graph. Templates are kept in the Graphs and Reports folder.

Plot

A portion of a graph containing a single group of traces, e.g. voltage and current for channel 1.

PQ

power quality
Ready Mode

An operational mode in which a PMI recorder actively records PQ data and can display real-time graphical data.

Recording Interval

The amount of time between data points, e.g. a 'one minute interval' means that the recorder will record a data point every minute.

Recording Session

A period of time during which power quality data is gathered by a PMI recorder.

Report Template

A blank form in which reports and graphs can be inserted to create a custom report. Templates are kept in the Graphs and Reports folder.

RTF

Rich-Text Format

Standby Mode

An operational mode in which a PMI recorder may be configured for recording PQ data.

Trace

A line drawn on a graph representing a series of data points.
Index

XE 79

A
Abnormal Voltage 37
Abnormal voltage event 37
Abnormal Voltage Records 98
  Trigger Logic 99
  Typical Settings and Suggested Uses 100
  What's Recorded 100
Activate 107
Active 107
Add Axes to Plots 64
Add Legends 67
Add Plots to Graph 63
Adding a Recorder 22
Adding Traces to Axes 65
Additional Resources 105
Adjusting Traces 60
Advanced Features 45
Annotating Graphs 48

Archiving Data 82
Arrow Annotation 51
auto-detect 25

B
Bluetooth® 17
Build the Report 71

C
Changing the Scale Factor 58, 76
Channel Names 38
Choose What to Create 71
Circuit Type 30
communication modes 17
Communications 17
Configuring a Recorder 25
Connecting a Recorder 4, 24
Creating a Mixed Graph 57
Creating Custom Graph Templates 63
Creating Custom Graphs 62
Creating Custom Reports 70
Current Range 30
Current Threshold 34
custom
  graph 62
  report 70
Customizing the Workspace 82
Cycle Histogram Records 88
Suggested Uses 89
What's Recorded 88

D
Daily Profile Records 87
  Suggested Uses 87
  What's Recorded 87
data
  real-time 79
  searching for 78
Data File 107
  archiving 82
  importing 78
  opening 3
  searching 78
Deleted 13
Demo Link 20
Devices pane 15
Diagnostics 80
Disable Keypad 38
Disconnecting a Recorder 24
Display High Resolution 38
Downloading a Recorder 5, 39

E
Editing Legends 45
Energy Usage Records 91
  Typical Settings and Suggested Uses 91
  What's Recorded 91
Event Change Records 94

F
Flicker Parameters 36
Flicker Records 97
  Trigger Logic 97
  Typical Settings and Suggested Uses 98
  What's Recorded 98

G
Generating a Graph 4
Generating a Report 4
Getting Started 3
Glossary of Terms 107
graph
  annotating 46
  creating 4
  custom 62
Graph Annotations 46
Graph Template 107
Graph Title 68
Graphs and Reports 11
Harmonic Graph (also known as harmonic bar graph or FFT Graph) 79
Harmonic Graphs 33
Harmonics
  1st – 8th 80
  9th – 16th 80
Horizontal Line Annotation 49

Identifying a Recorder 28
IEC Flicker (Pst Interval) 33
IEC Flicker Readings 80
Imported Files 12
Importing Data Files 78
Initializing a Recorder 5, 29
Interval Graph Memory Usage 39
Interval Graph Overwrite 30
Interval Graphs 33
Interval Records 84
  Typical Settings and Suggested Uses 85
  What's Recorded 84
Introducing ProVision™ 1

LED Indicator 38
Legend Editor 45
Line Annotation 52
Loose Neutral Parameters 35
Loose Neutral Records 100
  Trigger Logic 101
  Typical Settings and Suggested Uses 102
  What's Recorded 101

Main Readings 80
Managing Data 7
Managing Recorders 9
Meter Display 80
Minimum event time 35
Minute Histogram Records 90
  Suggested Uses 90
  What's Recorded 90
Modem Settings 38
Modes 17
Modify Parameters and Settings 73
Modify Report Elements 74

Name the Custom Report 75
Nominal voltage 35
Number of Channels 30

Opening a Data File 3
Organizing Information 7
Overwrite 34
P
Parametric Waveform 79
Period Capture 34
phasor diagram 79
Plot 107
Point Table 59
Pointer Annotation 53
Pointer for Annotation 48
Power Outage Records 96
PQ 107
Pre/Post Waveforms 34
Projects 11
Properties Pane 61

R
Ready Mode 108
Real Power Waveform 79
real time graph 79
Recent Downloads 11
Record Interval 30
Recorder Communication Settings 25
Recorder Connection Properties 27
Recorder Settings 16
Recording Data 43
Recording Interval 108
Recording Session 108
records
abnormal voltage 98
cycle histogram 88
daily profile 87
energy usage 91
event change 94
flicker 97
interval 84
loose neutral 100
minute histogram 90
power outage 96
significant change 92
waveform capture 102
report
creating 4
custom 70
Report Header 31
Report Template 108
resources
Technical Support 105
Retrieving a Setup 40
Rotary Switch Overwrite 39
RTF 108

S
Samples/Cycles 34
Saving a Graph as a Template 63
Scheduling Events 82
Searches 12
Searching for Data 78
Selecting Traces 55
Serial 19
Setting the Date and Time 41
Shortcut Bar 13
Significant Change Records 92
Trigger Logic 92
Typical Settings and Suggested Uses 93
What's Recorded 92
Significant Change Threshold 39
Standby Mode 108

T
Technical Support 105
Text Annotation 48
Threshold bands 35
Trace 108
Trace Properties 66
Trigger Thresholds 34
Tutorials 2
Types of Recorders 21
Types of Records 84

U
Understanding Recorder Records 105
Understanding System Folders 10
Understanding the Devices System Folders 16
Uploading Firmware 42
Using a Recorder 21
Using Link Annotations 47

Using the Custom Graph Wizard 63
Using the Custom Report Wizard 70
Using the Devices Pane 15
Configuring 15
Using the Explorer 10
Configuring 10
Using the Legend Editor 45
Using the Point Table 59
Using the Shortcut Bar 13
Configuring 14

V
Vector Diagram (also known as 79
Vertical Line Annotation 50
view 77
creating 77
default 77
Viewing Real-Time Data 79
Voltage & Current Number of Channels 34
Voltage Threshold 33

W
Waveform Capture Records 102
Trigger Logic 102
Typical Settings and Suggested Uses 103
What's Recorded 103
Waveform Graph 79
Wizard Finished 69
Wizards 1
Working with Graphs 45
Working with Groups 14
Working with Items 15
Working with Reports 69
Working with Views 77

X
X-Axis Annotation 54